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About the Accolade Education Program

This module is part of the Sopheon Accolade Education Program (AEP). The AEP modules are
designed to help Accolade users perform the tasks in their company's business process using the
Accolade application. The content in the modules is meant to be used side-by-side with the application,
and is part of the overall documentation suite provided for Accolade.

The benefits of using Accolade as part of your company's innovation development process include the
following:
¢ Reduced cycle time by displaying clear structure and visibility.
¢ Reduced rework through timely, properly sequenced completion of all key tasks and milestones.
¢ Assured positive user experience through properly developed product requirements.
¢ Improved communication by automating collaboration between multifunctional team members.

¢ Provided decision-making information. Poor projects are stopped or placed on hold so resources
can be redirected to more promising and higher value projects and products.

¢ Provided clear project requirements. Expectations of a project team and project manager at each
stage are clearly spelled out.

¢ Managed business risk. Break resource commitments into increments or stages.
¢ Established key baseline information and metrics.

The Accolade documentation suite contains the following additional components:

Document Contents
Sopheon Accolade What's New in This For each release, review this document for an
Release overview of the new features and changes within the
release.
Accolade Online Help Accessible directly through Accolade, the online Help

provides comprehensive how-to and reference
information about all aspects of using Accolade.

Sopheon Accolade Administrator's Guide Provides information for administrative professionals
regarding Accolade setup. This information is also
provided in the online Help.

Sopheon Accolade Installation Guide Provides information about the installation of the
application and its required databases.

Dashboards for Accolade Installation Guide | Provides installation information for installing the
Dashboards for Accolade component.

Quick Reference Cards A PDF that can be printed double-sided that provides
quick tips and navigation information for using
Accolade.
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Online Help for Accolade Add-ins

Accolade add-ins, including Accolade Office
Extensions, Accolade SmartDocuments for Google,
Accolade SmartDocuments for Office, Accolade
Portfolio Optimizer, and Accolade's integration with
Microsoft Project, each include their own Sopheon
created Help file accessible directly from the
application after the add-in is installed. Each Help file
describes how to use the features of that particular
add-in.

Prerequisites for Using this Module

The contents of this training module assumes you are assigned the Accolade user roles and have a
basic understanding of the terms and concepts listed below and how they are used in your installation.
In addition, the content in the related training modules listed below may be helpful before reviewing the

contents of this module.

Accolade User Roles

Process Designer E

Terms and Concepts Related Training Modules

Metadata * Process Design Overview
Metrics and Matrices

Reference Tables

User roles and rights

Access Groups

SQL Queries



Designing Charts and Reports

Reporting in Accolade provides a means to summarize and analyze project and other data within your
database, in a format and manner that is most applicable to your organization and data needs. Reports
can range from user login attempts to much more complicated reports used to analyze projects and
completion efficiency or financial information.

Reports can include:

Metrics

Project metadata

System data, such as user information
Accolade field codes

Reference table fields

Creating and adding reports within Accolade requires that you complete the following:

1.
2.

Determine what report type to create.

Define the basis for the report. This is a shell or template structure. When reports are viewed they
are populated with data from Accolade.

For MS Excel and HTML Reports, add the report to Accolade. Online reports created within
Accolade are added automatically.

Assign who has access and where the report displays.

Report Formats

Reports in Accolade can exist in the following formats:

¢ Accolade Online Reports - Online reports created within Accolade are built and viewable

directly within the application without having to write a SQL query. These reports provide an on-
demand reporting experience and can be used for the creation of Accolade charts. The ability to
create and modify online reports is available to any Accolade user assigned All Reporting Rights,
and anyone with Refresh Workbook Data rights can view these reports. These reports can be
added to the Charts & Reports page within Accolade, and can be added to a pod within a layout
in order to view them in projects.

HTML Reports - HTML reports can be built using a single SQL query to gather data from the
database, and display as a table in a secondary browser window. This format has no additional
formatting available, so can be useful for simplistic reports, for example, to determine where
process models are being used or to review user access history. HTML reports are also available
for users to send or receive via email. These reports can be added to the Configuration >
Charts & Reports tab within Accolade and can be added to a process model for availability in a
project.



¢ MS Excel Reports - MS Excel reports are built and viewable in Excel, provide flexibility in
formatting, and are created using the Accolade Office Extensions add-in application. The add-in
provides an interface to create a data report based on Accolade data. You can also create MS
Excel reports using a template and the Accolade query infrastructure, creating reports based on
data pulled into the spreadsheet using queries. These reports can be added to the
Configuration > Charts & Reports tab within Accolade and can be added to a process model
for availability within a project.

Each report type can contain the same data. The report type you choose to build depends on where the
report needs to display within Accolade, the means you want to use to build the report, and the amount
of formatting required to make the data within the report useful when viewing.

Report Access

Anyone in your organization can design a report, and anyone with All Reporting Rights can create and
save an online report. However, only Administrators and Process Designers can create MS Excel or
HTML reports, or set online reports as available for all users to view within Accolade. Only Process
Designers can associate a report with a process model to display within a project.

Users must have either Refresh Workbook Data or All Reporting Rights for access to view shared
reports in the Charts & Reports page and through the projects to which they have access. If the report
is restricted by role and/or by access group, users must have a system user role that matches the report
and/or be assigned to an access group that matches the report.

Additional rights are required to create and refresh report data using the Accolade Office Extensions
add-in.

Chart Formats

Charts in Accolade can be created using an Accolade online report as a source, and can exist in the
following formats:

° |_| - Bar charts

* “_ - Grouped bar charts

* |E_ - Stacked bar charts

* |_'l' - Bubble charts

* lb‘ - Line Chart Trends charts
* " - Pie charts

« @ _Radar charts

—

* €% _Unknown or custom charts

The chart type you choose to build depends on the data to be displayed, so it is important to select
appropriate data types to render a meaningful chart.



Charts Access

Using Accolade online report data, users with All Reporting Rights can create charts on the Charts &
Reports page. Administrators and Process Designers can set charts as available for sharing with other
users, and can add a chart to a pod within a layout to display on a project page or as a global link.

Users must have either Refresh Workbook Data or All Reporting Rights for access to view shared charts
in the Charts & Reports page and through the projects to which they have access. If the chart is
restricted by role and/or by access group, users must have a system user role that matches the chart
and/or be assigned to an access group that matches the chart.

Filtering Capabilities

Take advantage of Accolade's filtering capabilities to assist users in identifying specific charts and
reports from their list. Users now have the ability to filter their Charts & Reports list by Name, Category,
and Type:

¢ Access the Accolade application.
¢ Navigate to the My Charts & Reports section.

* View and manage the filtering options on the top-right corner: Name, Category, and Type.

* Reports Best Practices

Keep the following set of best practice recommendations in mind when creating and planning charts
and reports:

¢ Consider Project and Data Security - Remember, reports respect the security features such
as access groups and security lists that Administrators have defined within the system. For
example, users who select to receive an HTML report through email receive a report that
contains only information for projects to which they have access. However, reports contained in
emails, including those added as attachments, can contain private information that should not be
shared internally or externally. Use the Report Privacy Warning Text system parameter to add
a line of warning text to Accolade Online reports, HTML reports, and reports created using
Accolade Office Extensions, to indicate the private or confidential nature of the report contents.
The parameter provides 500 characters for the message.

In addition, all reports created using Accolade Online Reporting and Accolade Office Extensions
contain a custom property that identifies the generated file as a file with Accolade data. To help
ensure sensitive data is not forwarded, use the filter options on your email server to prevent files
that contain the custom property from being forwarded using email.

¢ Choose the Best Report Format and Creation Method - The report type you choose to build
depends on where the report needs to display within Accolade, the means you want to use to



build the report, and the amount of formatting required to make the data within the report useful
when viewing.

Method Advantages

Accolade Online Accolade Online reports use a reporting interface similar to that
Reporting provided with the Accolade Office Extensions, but without having to
leave Accolade and without having to access Excel.

Accolade Online reports provide an on-demand, in-application way
to generate a report and ensure that the report always displays the
real-time data from Accolade.

Accolade Office Accolade supports .xIsx, .xIsm, .xltx, and. xItm file types for MS
Extensions Excel reports. Accolade Office Extensions provides an interface to
create a data report. Creating reports in Excel also allows for Excel
formatting, as necessary.

You can use reports created with Accolade Office Extensions in
your process documents, add them to related documents, email
them, use them for your own research, or (if you are an
Administrator or Process Designer) you can activate them on the
Configuration > Charts & Reports tab or on the Reports List
pod in projects.

SQL Queries Complicated tables may require the use of SQL queries, for
example, tables that require aggregations other than sum, average,
minimum, maximum, or standard deviation, or in tables with filters
joined with "or".

SQL queries leverage the reporting views to gather data from the
Accolade database and require some knowledge about writing a
successful query to gather the information you want. You can also
write your own custom reporting views to retrieve information from
the database.

When you create charts and reports based on SQL queries, you
can include them on the Charts & Reports page or on the Reports
List pod in projects, but you cannot add these reports to documents
or use them in the other ways that are available to Excel reports.

Accolade Online Reporting Overview

Accolade Online Reporting provides an on-demand reporting option and can be added to the Charts &
Reports page within Accolade. Any Accolade user assigned All Reporting Rights can create online
reports within Accolade.

An online report consists of the following components:

¢ Data columns - Determines the area of the database, for example Projects or Access Groups,
that are available to retrieve information from.



¢ Filters - Specifies the criteria to match to include data in the report from specified columns.

¢ Users - Indicates which Accolade users have access to view and edit the report. Each selected
user must have report refresh rights to see the report. Users with all Reporting Rights also have
access to change the selected columns and filters within the report definition.

Creating Online Reports within Accolade

Online reports provide an on-demand reporting option and can be added to the Charts & Reports page
within Accolade. Any Accolade user assigned All Reporting Rights can create online reports. Generated
content can be added as a report in a project by adding a Report pod to a layout, and then adding the
layout to a process model.

Use the Report Privacy Warning Text system parameter to add a notification
within the report to indicate the content is private or confidential, and should not be
forwarded to others.

To create an online report within Accolade:

1. From the Workspace menu, select Charts & Reports.

To narrow the list, search by the report name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the System menu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:
¢ To add a new report - Click Add New and select Online Report from the drop-down list.

¢ To copy an existing report - Locate the report you wish to copy on the Charts & Reports
page.

Click in the Copy column. Select, add, or rearrange the columns you wish to
keep. You can also add filters and advanced matrix settings. Click OK to save
changes and progress to the next step. Give your newly copied report a name, a
system name, a category, and a description. Decide if you wish to transpose the
column and row data. Click Save to create the report.

¢ To edit an existing report - Click the name of the report on the Charts & Reports page to
open it for editing, Click G to edit the report columns, or click # toeditthe report details.

Only users assigned as report owners and Process Designers with All Reporting
Rights can edit report columns and details.

3. Select a subject from the drop-down list, such as Projects or Users, to display the column sets
available within that subject.

4. Double-click or drag and drop the column names from the left side of the dialog to any area in the
Selected Columns tab to include the column in the report.



¢ To search for a column, enter search criteria in the Find field after selecting the subject.

* Usethe and [=] options to expand or collapse the subject data sets in order to select
specific column options.

¢ Toinclude an entire column set, drag and drop the column set to the Selected Columns tab.

¢ To change the column order of selected columns, drag and drop a column into a new location
within the list.

¢ Todisplay the totals for number columns, check the Show Totals option to indicate that you
would like to sum up a number column into a Totals row at the bottom of the report.

¢ Toremove a column, click O in the corresponding row.

(Optional) Refine the content of the report as necessary using one or more of the following
options.
* Rename columns - Click in one or more selected columns and enter a new column name
that is more appropriate for the report you are creating.

¢ Set column sorting - Click - next to one or more selected columns to indicate whether the
column is sorted in ascending or descending order. If you select more than one column to
sort by, indicate the order in which the columns sort; 1 being the primary sort, 2 the
secondary sort, and so on.

¢ Create project links - If the Project Name report column is selected for inclusion in the
report, select the Is Link check box to make the project name in a report linkable to the
project's home page.

« Define column properties - In the Properties area, define the column display and behavior
including grouping items together to aggregate them and Excel date intervals. Aggregate
selections are only available for number metric columns.

For example, to summarize the total costs for all projects within a brand, select Sum as the
aggregate value in a column that represents the total costs for a project. The aggregation
displays automatically when the report is selected to display in a chart.

« Data Format - If the column contains a date or a number, select how the data should be
displayed. The currency symbol that displays for numbers is defined in the Currency
Symbol system parameter.

¢ Hide columns - Make a selection in the Show check box to show or hide columns within the
displayed report.

¢ Add Count Column - If you select to summarize values within the report, click + Add
Count Column to add a column that shows how many rows of source data are combined in
the summary row.

You can order and rename the added column as you can other columns; however,
you can add only one Count column to the report.



* Add Calculated Column - Click (+] Add Calculated Column to add a column to the report
that displays a calculation based on other column data.

(Optional) On the Selected Filters tab, double-click or drag and drop the column name from the
left side of the dialog to any area in the Selected Filters tab to use it as filter criteria that data
must match to be included in the report.

. Onthe Advanced Matrix Settings tab, if more than one matrix was selected in the report

columns, click L+ Add to add the matrix join definitions.

. Click OK to exit the dialog and return to the report settings.

Enter the following information to identify the report:

Required fields display with red text and an asterisk * if the field is empty.

Field Description
Name Enter a name, up to 64 characters long, which identifies the
report.
System Name Enter a unique, shorter name that identifies the report in queries,

reporting views, field codes, and other places in Accolade.

The name must be unique among online reports and can contain
only letters (English alphabet), numbers, and the underscore.

Category Enter or select the group to which this report belongs.

Use categories to organize like reports together. For example, if
there are a large number of reports that the IT department uses
to track user logins, use a category to group those reports
together.

» Leave this field blank to add to the Default category.

» Todefine a new category, select New Category and enter
the category name.

» Todelete a category, remove every item from the category.
Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the report.

This description helps other users identify the report throughout
the system.

Transpose Select this check box to transpose the column and row data
when the report is rendered.

Owners Click [} and select the additional users who can edit the report

configuration.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.

« Clicking Select current user will assign the role to the




Field Description

current user (if they have the appropriate rights).

« Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

 Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the report.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the report. To make the
report available for all users or for configuration setup,
you must have a Process Designers with All Reporting
Rights as an assigned owner.

10. (All optional, available in configuration only) Enter the following information to make the chart
publicly available.

Field Description

Override project Select this check box to include the entire report set from
filtering within a project.

The report will not filter to project-specific data when viewed
from within a project, and will display all projects in a portfolio
regardless of security.

*Note* This check box will not be available for selection if the
Filter to Portfolio check box is selected.

Filter to Portfolio Select this check box to display the Portfolio Levels To Display
slider.

*Note* This check box will not be available for selection if
Override Project Filtering check box is selected. This check box
is optional and is not mandatory.

Portfolio Levels To Select this toggle as well as the Filter to Portfolio check box so
Display that the report will filter to that project Portfolio Hierarchy
instead of the default of filtering down to just that project.

*Note* This toggle is optional and is not mandatory.
Available to Charts & | Select this check box to make the report publicly available for
Reports users to access and view the report.




11.
12.

13.

Field

Description

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able to
view the report in the Shared Charts & Reports section on
the Charts & Reports page.

Available to
Configuration

Select this check box to make the report available for use in
configuration.

Roles

Select the user roles that have access to view the report.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able to
view the report on the Charts & Reports page.

Configuration
Access Groups

When either Available to check box is selected, access
groups must be defined for the report.

The access groups displayed are based on the current user's
access group permissions and the access groups the report
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the report.

Process Model
Usage

Click the Process Model Usage button to see a list of
process models that the online report is associated with.

The list includes all process models the report is included in,
as well as links to the process model's component tree pages
you have Edit access to.

Note: Clicking either Available to check box will place the report in the Shared

Charts & Reports section of the Charts & Reports page. If neither check box

is selected, the report will only be available to the assigned owners in their My
Charts & Reports section.

(Optional, available in configuration only) Set up the report for export.

(Optional) Click €linthe upper right corner to display a preview of the report contents prior to

saving, or click :'Ir to download the report to a spreadsheet file.

Click Save to create a new report, or to save changes to an existing report.




Conditional Formatting in Reports

Accolade users need an easy way to focus on the most critical information in the report. Users can
easily use conditional formatting on report columns such as date, number, or text to focus attention on
the key data to drive decisions on projects. Users can specify a formula that tells the report how to color
the background of the cells in a given column. For example, while setting up the report, one can choose
to highlight the project duration column which will show the long-running projects as risks. The user
would be specifying the criteria such as a project running greater than 500 days will have the color red,
projects running between 200 and 500 days will be yellow, and projects running less than 200 days will
be green. This will effectively highlight projects that have been running for a very long time.

1. Access the report you wish to configure.

o
2. Click the Settings icon at the top right of the report page. The Selected Columns screen

will appear.
“selected Columns | selected Filters  Advanced Matrix Settings
Columns Sort IsLink Properties Data Format  Show Total ~ Conditional Show
Foratting
Project Name : & [x]
Project Thumbnail el [x)
Project Description & [x)
Project Currency Code & [x]
Project Currency Name o (x]
Project Currency Conversion Factor s (None ] [1000;(10v] O o (%]

Project ID A

3. Select the Settings icon in the Conditional Formatting column. The Conditional Formatting
modal will appear.

Conditional Formatting X
Value Color 0
[=New Product Development ] [0 @
ama ) @B ©

\ I B -

4. Configure the fields. Click the OK button when finished.

5. Click the OK button on the Select Columns page to finalize preferences.



How Do | Know the Feature is Working?

Users have the ability to input formulas into the Value fields of the Conditional Formatting modal. Use
Rational and Logical Operators to express what actions should take place when the desired criteria is
met. Follow the steps below to guide you through this feature. IF help is needed, use the Valid
Operators as a reference.

Relational Operators Logical Operators

= (Equals) Or, || (Double Pipe)

<> (Does Not Equal) And, &&

>= (Greater Than or Equal To)

<= (Less Than or Equal To)

> (Greater Than)

< (Less Than)

¢ To make a valid formula, you need at least one of the relational operators from the table above,
and at least one value.

¢ j.e.=Red
e j.e.>=0

¢ If you’re using any logical operators (i.e. &&) then you’ll need at least 2 relational operators and
at least 2 values per logical operator.

e ie.>1]|<0
¢ Comparisons to Dates need to be specified in the YYYY-MM-DD format.

¢ i.e.<2025-03-25, if you want all dates less than March 25th 2025 to be formatted.

Notes:

* To delete a saved online report, click the name of the report on the Charts & Reports
page and click Delete at the bottom of the page. Only the report owner, users assigned as
owners with All Reporting Rights, and Process Designers with All Reporting Rights can
delete the report.

¢ Toinclude a project's thumbnail image in the report, add the Project Thumbnail column
available in the Project Details column set.

¢ A reference table must also be added to Accolade as an online report in order to be
available to use in reporting. The reference table information is included by selecting the
Reference Tables option when selecting columns to be included in the report.

¢ The process model determines whether the report is available at the project level. When
viewed through a project, only data that pertains to that project displays in the report,
unless Override project filtering is set in the report configuration. Non-project related



information displays identically in both locations. Click %= onthe Reports page of the
project to print the list of charts and reports that display.

» Usingfilters that reference data with square brackets may not return correct results. Itis
not recommended to use square brackets in naming projects or other Accolade data, as
these characters are not supported in filtering and calculation functionality.

¢ Use the Currency Symbol system parameter to specify the currency symbol that
displays in the Data Format field when creating charts and reports.

¢ Users can now use the phrase "NULL_OR_EMPTY" in the Conditional Formatting feature
to format NULL/[EMPTY] values (Determined by the Replace Empty Values parameter 1
([EMPTYT]) O (NULL)).

Adding Calculated Columns to Online Reports

Reporting details can be contained in multiple sources within Accolade. To combined related data

values to be used for reporting or the creation of charts or presentations, users can create reports that
include calculated columns that calculate and/or display combined data, allowing users to manipulate

and analyze Accolade data values.

For example, a user may have several different project metrics that represent categories of project costs

such as Administrative, Operating, Marketing, etc. In order to calculate and display the sum of these

project costs within an Accolade report or chart, the user can include a calculated column in their report

setup.

oty
EXAMPLE
"y Example

Writing a calculated column formula in Accolade is slightly different than writing an equation in math
class, or using formulas in Excel. The most notable difference is the use of the equal sign (=).

For example, if you want to add the numbers 3 and 2:

¢ In math class, the equation would read 3+2=, with a calculated value of 5.

¢ In Excel, formulas start with the equal sign, so it would look like =3+2. When entered, the value in
the selected cell would return as 5. If you wanted to add two cell values, it would look something
like =A1+B1 or =SUM(A1:B1). Assuming the values in A1 and B1 were 3 and 2 respectively, it

would return the value 5.
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¢ In Accolade online reporting, the equal sign is assumed, so it does not need to be included in the
formula field. If you wanted to add the values of Column A and Column B, it would look like
[Column A] + [Column B] or Sum([Column A], [Column B]). Assuming the first row values of
Column A and Column B were 3 and 2 respectively, it would return the value 5.

WARMING: Do not share confidential information. Vielators will be prosecuted!

Project Name Column A Column B Sum of Columns A& B
Project Example 1 3 2 5

Project Example 2 4 g 13

Froject Example 3 . 7 g

To add a calculated column to an online report:

Note: See below for a list of calculations that are currently supported for reporting.

1. Create a new report or open an existing report for editing.

2. Onthe Selected Columns tab, ensure the columns to be used in the calculation are included in
the report.

Report calculations are executed from left to right. In order for selected columns to
be used in a calculated column, they must a) be selected as a column for the
report, and b) be included before they are referenced by a calculated column (this
means they must appear to the left of the calculated column when displayed, or
above the calculated column when selecting columns in the report setup).

3. Make a selection in the Show check box to show or hide columns within the displayed report.

If you want to use the columns as a reference for calculated column formulas but do not wish to
display them in the report, clear the Show check box. Hidden columns can still be used as a
reference for calculated columns, but will not appear in the report when displayed.

4. Click @ Add Calculated Column.

The column is added with two fields - one for the display name for the column, and one for the
formula to be calculated.



5. Inthe top field, enter the column name to be displayed when the report is generated.

6. Inthe )( field, enter the formula to be calculated within the report.

When entering your formula, the columns are referenced by enclosing the column display name
inside of square brackets. In the example above, Column A is entered as [Column A].

7. Select the appropriate datatype for the calculated column.

« Date - Select this option when you want the column data to display as a Date datatype, for
example when using the DateAdd function to project a future project date.

¢ Number - Select this option when you want the column data to display as a Number datatype,
for example when using the Sum function to combine the values of two or more columns of
expense values.

¢ String - Select this option when you want the column data to display as a String datatype, for
example when using the Concatenate function to display user name and functions combined
in one column.

7. (Optional) Drag and drop the calculated column to a new location within the list.

Note that while the calculated column cannot be displayed in the report until after its reference
columns are displayed, you can have calculated columns that are displayed between data
columns as necessary. Using the example above, after the Sum column we could add Column
C and Column D to the report and then add another calculated column, and so forth.

8. Click OK to exit the dialog and return to the report settings.
9. Finish setting up the report, as necessary.

10. (Optional) Click €lin the upper right corner to display a preview of the report contents prior to

saving, or click [3 to download the report to a spreadsheet file.

11. Click Save to create a new report, or to save changes to an existing report.

Available Formulas for Calculated Columns in Reporting

The following section details the operators and functions that are available for use when creating your
calculated column formulas.

Important! Note that the examples use "Column A", "Column B", and "Column C" to
generically refer to the display names of different columns that are included in the report
data.

Operators

Operators are process or mathematical parts of expressions, such as addition and multiplication, and
relationships such as greater than or less than. Use the operators below within your calculated column
expressions.



Operator Example

Additive and Subtractive Operators

+ (plus, plus sign) [Column A]+[Column B]

- (minus, dash) [Column A]-[Column B]

Multiplicative Operators

* (multiplied by, asterisk) [Column A]*5
/ (divided by, slash) [Column A)/[Column B]
% (mod, percent sign) [Column A]%10

Primary Operators

value (integers, text strings, ('this is a text string')

dates, functions)
While single quotes work for dates,

we recommend wrapping dates in
pound or hash signs instead to
ensure consistency of data types.
For example, (#2021-10-19#).

() (parentheses) 1000-(6*[Column A])

Relational Operators

= (equals) [Column A]=250

<> (does not equal) [Column A]<>[Column B]

> (greater than, angle bracket) | [Column A]>250

>= (greater than or equal to) [Column A]>=250

< (less than, angle bracket) [Column A]<500

<= (less than or equal to) [Column A]<=100

Logical Operators

or, || (double pipe) [Column A]<[Column B]||[Column A]<500
and, && [Column A]<[Column B]&&[Column A]<1000
Functions

The functions included in the calculated column formula determine in part what is returned in the
column. Use the functions described below within your calculated expressions to return data within a
calculated column.



For more information on the description or formatting for the calculations below, see Calculated Metric

Expressions Reference.

Function Example Formula
Abs Abs([Column A])
Acos Acos([Column A])
Asin Asin([Column A])
Atan Atan([Column A])
Avg Avg([Column A], [Column B], [Column C])
Ceiling Ceiling([Column A])
Concatenate Concatenate('text1',[Column A], 'text2', 'textN')
Contains Contains([Column A], 'My Blue Heaven', 2, 7)
Cos Cos([Column A])
DateAdd DateAdd('D', 5, [Column A])
DateDiff DateDiff('D',[Column A], [Column B])
DatePart DatePart('M', [Column A])
Exp Exp([Column A])
Find Find([Column A], 'My Blue Heaven', 2, 20)
First First([Column A], [Column B], [Column C])
Floor Floor([Column A])
IEEERemainder IEEERemainder([Column A], [Column B])
If If([Column A]>500, 'Go ahead', 'Stop")
In In([Column A], 1, 2, 3)
Join Join([Column A], [Column B], [Column CJ), ')
Length Length([Column A])
Log Log([Column A], 10)
Log10 Log10([Column A])
Lower Lower([Column A])
LTrim LTrim([Column A])
Max Max([Column A], [Column B], [Column C])
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Function Example Formula
Min Min([Column A], [Column B], [Column C])
Now Now()
Pow Pow([Column A], 2)
Replace Replace([Column A], 'Blue', 'red")
Round Round([Column A], 2)
RTrim RTrim([Column A])
Search Search('blue’, [Column A], 5, 30).
Sign Sign([Column A])
Sin Sin([Column A])
Sqrt Sqrt([Column A])
SubString SubString([Column A], 4, 10)
Sum Sum([Column A], [Column B], [Column C])
Tan Tan([Column A])
Trim Trim([Column A])
Truncate Truncate([Column A])
Upper Upper([Column A])
Notes:

¢ To delete a calculated column from a report, click the name of the report on the Charts &
Reports page and click 7/ to display the report columns. Click the Selected Columns

tab, and click in the corresponding calculated column row to delete it. Click OK to
close the dialog and click Save to save the changes to the report.

Adding Dynamic Filters to Online Reports

Capture and filter report data using relative metric and metadata field codes to create dynamic reports
that display data according to the project it is viewed within. Filtering reports based on relative metrics
and metadata field codes allows you to narrow the returned data set while still generating a higher-level
view. Dynamic filters allow you to view a subset of data from within different projects.

Important! Ensure the Override project filtering check box is selected on the report
settings. This enables the report to include data across a subset of projects.




To add dynamic filters to an online report:

1.

2.
3.

Create a new report, or open an existing report for editing.

Click ## inthe upper right corner to view the report details, and click the Selected Filters tab.

To add filters, double-click or drag and drop the column names from the left side of the dialog to
any area in the Selected Filters tab.

¢ To search for a column to add as a filter, enter search criteria in the Find field after selecting
the subject.

¢ Toinclude an entire column set, drag and drop the column set to any area in the Selected
Filters tab.

If multiple filters are added to the report, data must meet ALL filter criteria to be
included in the report.

For each added filter, select the operator and filter criteria that report data must match to be
included.

The filter operators are dependent on the column selected to filter by, and generally include
options such as =, is empty, is one of, does not contain, and more.

The filter type must be selected from one of the following, and the following field identifies the
criteria to be met:

¢ Metadata - Enter the field code display name and select from the returned list. Ensure you
enter a valid query field code. While some operators may work in global level reports, this filter
type is designed to only work in reports pulled into project layouts via the Report pod (project
level reports).

¢ Metric - Enter the metric display name and select from the returned list. While some operators
may work in global level reports, this filter type is designed to only work in reports pulled into
project layouts via the Report pod (project level reports).

¢ Text - Enter or select a static string or numeric value such as a date.

¢ Current User - Filters the report to data only applicable to the user logged in and viewing the
report. Current User is only available for numeric or ID data type columns.

Type ahead to search for metrics and field codes when defining the filter criteria.
Only metrics and field codes that match the data type of the filter display for
selection. For example, if you select a date filter, you can only select date metrics
or field codes to define the relative filter.

For example, to create a report that returns a list of deactivated users, filter on the User Active
column to return only users where the active flag is set to No. To set up this filter, the operator
selected is =, the type selected is Text, and the criteria is No.
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Selected Columns | Selected Filters | Advanced Matrix Settings

Project ID

! Runtime Filter

5. (Optional) Select the Runtime Filter check box to determine what filters are available for users
to apply when refreshing the data in the report.

6. Click OKto exit the dialog and return to the report settings.
7. Finish setting up the report, as necessary.

8. (Optional) Click Q in the upper right corner to display a preview of the report contents prior to
saving, or click :'Ir to download the report to a spreadsheet file.

9. Click Save to create a new report, or to save changes to an existing report.

Notes:

« To delete afilter from a report, click the name of the report on the Charts & Reports page

and click # to display the report columns. Click the Selected Filters tab, and click O in
the corresponding filter row to delete it. Click OK to close the dialog and click Save to
save the changes to the report.

 Filter icon will not appear if there are no filters available for users to apply.

¢ Long string and multi-select list metrics are currently not supported for use as metric
filters.

Adding Multiple Matrices to Online Reports

Reporting details can be contained in multiple sources within Accolade. To consolidate data into a
single source to be used for reporting or the creation of charts or presentations, users can create reports
to combine the data. Information from more than one project matrix can be pulled into a report by

including a common value that is included in the sources, for example, using a Department or Region
metric or a common Row ID.

In addition to selecting the matrix and metric columns to be included in the report, users must create join
statements that define how the matrix information is related.



Common
Value

Matrix A Matrix B

To add multiple matrices to an Accolade online report:

1.

2
3.
4

Create a new report or open an existing report for editing.

. Onthe Selected Columns tab, select the matrices and metrics to be included in the report.

On the Advanced Matrix Settings tab, click L+ Add to add the matrix join statements.

In each side of the dialog, select one of the matrices from the drop-down list, and select an option
to use as the common value to join the matrices.

The two selected matrices must be different, but the matrix/metric combination can be any
combination of metrics or row IDs, as long as the selected metrics share a common value and
are of the same data type.

Selecting a metric will define it as the common value between the two matrices. Note that it can
be the same metric if it is used in both matrices, or it can be different metrics that will have the
same value in both matrices. In addition, a metric used as a common value does not need to be
added as a reporting column in order to be used to create the join statement.

Selecting Row ID will compare matrices by rows, for example Row 1 in Matrix A will be compared
with Row 1 in Matrix B, and so on. This can be used when there are no additional common values
in the two matrices, and the matrices have a direct line-by-line comparison.

/l} Caution! Selecting Row ID as a common value can cause inconsistencies in
reporting. Since assigned Row IDs are not visible within a matrix, report results
can be incorrect if rows have been deleted from a matrix or if there is a mismatch.
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5. Repeat steps 3-4 to add additional matrix join statements as necessary.

All included matrices must have at least one related join statement, but a matrix can be
referenced in more than one statement. For example, if you choose to include metrics from
Matrix A, Matrix B, and Matrix C, you would need to create two statements to join the information.
You could create a statement that relates A to B, and one that relates B to C, or you could have a
statement that relates A to B, and one that relates A to C.

6. Click OK to exit the dialog and return to the report settings.

7. Finish setting up the report, as necessary.

8. (Optional) Click Q in the upper right corner to display a preview of the report contents prior to

saving, or click [3 to download the report to a spreadsheet file.

9. Click Save to create a new report, or to save changes to an existing report.

Note: [EMPTY] or blank cells in your report may indicate a mismatch in the common value
linking the matrices. If the project value referenced in the join statement is not defined
in one of the matrices, for example if there is not a matching value in both matrices, or
a matrix contains empty rows, the report will return partial or full rows that contain
[EMPTY] values.

g
EnIPLE Example
For example, a user has two different matrices that contain information related to vendor contracts for
their projects, and needs to create a report containing relevant information from both matrices. They
have a matrix named Contract Information, which contains the start date and duration of the specific
contracts, and a second matrix named Contract Cost, which contains the costs related to the specific
contracts.



To pull this information into one report, the user has added the related columns to the Columns tab, and
created a join statement in the Advanced Matrix Settings tab that links the two matrices using the
Contract ID metric that is a member of both matrices.

select Columns. @ < X
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Once the user enters the remaining report details and clicks OK, the following report is generated:

Contract Information Matrix Contract Cost Matrix
e
Project Name Contract ID Contract Start Date Contract Duration Contract ID One-Time Costs Contract Costs
Emotion Electronics A100 2019-06-01 12 Month Term A100 2100 12500
Emotion Electronics A101 2020-06-01 12 Month Term [EMPTY] 0 0
Emotion Electronics [EMPTY] 1900-01-01 [EMPTY] A110 1400 12500
Smith Marketing 28501 2019-06-01 12 Month Term 28501 8400 10125
Smith Marketing 34886 2019-06-01 12 Month Term 34886 1850 12750
Express Services 001684-0197 2019-10-21 24 Month Term 001684-0197 0 1840
ACME Company AC1217 2018-04-01 12 Month Term ACI217 2500 5000
ACME Company AC1924 2019-04-01 12 Month Term AC1924 0 5300
ACME Company AC2101 2020-04-01 12 Month Term AC2101 500 6150
Fred's Grocery [EMPTY] 1900-01-01 [EMPTY] [EMPTY] 0 0
Fred's Grocery [EMPTY] 1900-01-01 [EMPTY] [EMPTY] 0 0

Note the following:

The Contract ID field is the common identifier included in both matrices, and used to connect the
relevant information.

The left three columns contain information that is from the Contract Information matrix in the related
projects.

The right three columns contain information that is from the Contract Cost matrix in the related
projects.

The highlighted sections below show two different scenarios that may indicate missing or incomplete
data.



¢ Rows 2 & 3 of the report display [EMPTY] in some of the data cells, which indicates Contract IDs
values that are not found in both matrices. In row 2, the information for contract A101 is only
included in the Contract Information matrix, so the related Contract Cost matrix fields are
[EMPTY]. In row 3, the information for contract A110 is only included in the Contract Cost matrix,
so the related Contract Information matrix fields are [EMPTY].

¢ Rows 10 & 11 display [EMPTY] cells in all of the data cells, which indicates that one or more of
the included matrices either does not have any rows added, or contains empty rows.

Note: Although the [EMPTY] returned values are an indicator of potential issues, the
mismatched values reported are dependent on the datatype. String and list metrics
will display as [EMPTY]. As shown in the example below, a number metric will display
0, and a date metric will represent the default 1/1/1900 date.

8727

Project Name Contract ID Contract Start Date Contract Duration Contract ID One-Time Costs Contract Costs
Emotion Electronics A100 2019-06-01 12 Month Term A100 2100 12500
Emotion Electronics A101 2020-06-01 12 Month Term [EMPTY] 0 0
Emotion Electronics [EMPTY] 1900-01-01 [EMPTY] A110 1400 12500
Smith Marketing 28501 2019-06-01 12 Month Term 28501 B400 10125
Smith Marketing 34886 12 Month Term 34886 1850 12750
Express Services 001684-0197 2018-10-21 24 Month Term 001684-0197 0 1840

AC1217 2018-04-01 12 Month Term AC1217 2500 5000

AC1924 2013-04-01 12 Month Term AC1924 0 5300
ACME Company AC2101 2020-04-01 12 Month Term AC2101 500 6130
Fred's Grocery [EMPTY] 1900-01-01 [EMPTY] [EMPTY] 0 0
Fred's Grocery [EMPTY] 1900-01-01 [EMPTY] [EMPTY] 0

Notes:
¢ To delete a matrix join statement from a report, click the name of the report on the Charts
& Reports page and click / to display the report columns. Click the Advanced Matrix

Settings tab, and click € inthe corresponding definition row to delete it. Click OK to
close the dialog and click Save to save the changes to the report.



Downloading and Exporting Online Report Data

Users with access to a report can download the content of a saved online report directly from Accolade.
Report creators can also set a report to export to a network location on a scheduled basis. Schedule a
report for repeated exports if you save archive information on your network, or to provide access to a
report to someone who is not an Accolade user.

To download report configuration and settings for the purpose of exporting reports
between Accolade instances, see "Importing and Exporting Accolade Online
Reports" on page 34.

To download a saved online report:
1. From the Workspace menu, select My Workspace > Charts & Reports.

2. Click the name of the report you want to view.

E identifies reports created using Accolade Office Extensions. To refine the list of reports
displayed, select a category from the Category field or use the Search field to search on report
names and descriptions. If the Category field is unavailable, all reports are grouped within a
single category.

Online

Report — a Sales by Market Portfolio Reports
[ sales by Project [Default]
u Sales by Project [Default]

(, TL Pie Sales by Relative Year [Default]

3. Click ﬂ in the top right corner of the report display page.

Accolade downloads the report contents to spreadsheet file and saves it to a temporary internet
files directory, using the report's system name as the file name. Save the file to a more
accessible location.

4. Ifthe document is a template, Administrators and Process Designers with the Template Access
role can save the file and add it to the Template Library as a process document.

If the document is a deliverable, activity, or gate document, the assigned document owners can
save a version of the file to project.
To schedule a report to export to a network location:
1. From the System menu, select Content Sources > Charts & Reports Manager.

2. Do one of the following:

¢ To create a new report - Click Add New, select Online Report from the drop-down list and
create a new report.



¢ To edit the export settings of an existing report - Click the name of the report on the
Charts & Reports Manager page and click # inthe upper right corner of the title in the
displayed report.

3. Inthe Export Days field and the Export Time field, select the days of the week on which
Accolade should export and enter the time the export should take place.

You must select at least one day to schedule the export. The export takes place based on the
Accolade server's time, not your local time settings. If the Accolade server is located in a different
time zone, ensure you are scheduling the time accurately for the export.

4. Complete the following to identify the export location and report name:

Field Description

Export File Path Enter the directory location where the exported file is saved.

The Accolade timed task service must have access to the
network drive. Work with your system administrators to
understand what network shares are available for use.
Filename Enter the file name for the report. To append a timestamp to the
file name, select the Include timestamp check box.

Timestamps can be helpful to identify exactly when a report was
exported and saved to the network directory.

5. Inthe File Type field, select whether to download the file as a spreadsheet file, or as a file with a
.csv extension which can be opened in other spreadsheet programs.

If you select to download to CSV and have text set in the Report Privacy Warning Text system
parameter, the text is notincluded in the CSV file.

6. Click Save to save the report and the export settings.

Notes:

* The Timed Task Service must be enabled and running on the Accolade server for a
scheduled export to save successfully. Contact your Accolade system administrator to
ensure the service is running.

« If a scheduled export fails to save, the report creator receives a notification email about
the failure.

¢ The colors defined in the Excel Header Background Color, Excel Header Font Color,
and Excel Header Is Bold system parameters determine the formatting of the header
rows within the spreadsheet file.



Adding Accolade Online Reporting Content to Templates

Add the content of a report created within Accolade to an existing document or template using a specific
named range. When downloading the report, template, or a document version with the report content,
the up-to-date Accolade data is included in the file.

A spreadsheet template containing content created within Accolade can also be
used as the template for a deliverable or activity. Administrators and Process
Designers with the Template Access role can save the file and add it to the
Template Library as a Process Document type template instead of as a Report

type.

To add content from an online report to an existing spreadsheet file:
1. Note the system name of the report in Accolade.
2. Select the cell within the spreadsheet where the report content should begin.

When the file is downloaded from Accolade, the report contents start at the cell with the named
range, and expands to the right and below for the required number of columns and rows to
accommodate the data.

Important! Any information in cells to the right of the one with named range could be
deleted based on the report's content. Any information below the cell with the named range
is pushed to below the report's content.

3. Inthe Name field for the cell, enter SGM_RG_<RGReportName> and press Enter.
B2 - X

Name field

For example, to include a report with the system name ModelsinUse, enter SGM_RG_
ModelsIinUse as the cell name.

Notes:

» Using this function to associate a spreadsheet workbook with report content to a project
does not display project level data.



Importing and Exporting Accolade Online Reports

Accolade provides Administrators and Process Designers the ability to export Accolade online reports
settings and configuration from one Accolade environment and import them into another Accolade
environment. For example, your company may have separate test and production environments or
company branches hosted in separate Accolade instances. Instead of having to recreate online reports
in each environment, download the information and import into a different environment.

The download exports the online reports configuration information into a spreadsheet file with the parts
of the reports grouped into tabs.

To export report settings:

1.
2.

From the System menu, select Content Sources > Charts & Reports Manager.
Select the reports that you want to download.

To narrow the list by report name or system name, add the criteria to filter by in the appropriate
filter text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list. To download all
charts and reports, select All.

Click Download in the top right corner of the page.

Accolade downloads all configured charts and reports in four separate spreadsheet files within a
zip file, and saves it to a temporary internet files directory. Online report settings are downloaded
to a workbook titled RPT_Workbook.xIsx. Save the file to a more accessible location.

Note: Only components to which you have view and/or edit configuration access group
rights will download. Components you can only view may be included in the file, but
you can only upload changes to areas to which you have explicit edit permission.

To import report settings into Accolade:

1.
2.

Ensure the data within the spreadsheet meets the requirements for a successful import.

Remove any reports that you do not want to include in the upload from the spreadsheet and save
the file.

From the System menu, select Content Sources > Charts & Reports Manager.
Click Upload in the top right corner of the page.

Click Load File and select the spreadsheet file to load. The file name must be prefixed with
'RPT_"in order to successfully upload.

Click Upload File.

Accolade uploads the changes to the existing reports in the spreadsheet, and adds any new
reports with unique system names.

(Optional) Click Print to print the import results for your records.



Note: Components that are imported are subject to group configuration rules. The user may
assign components in a way that the configuration access groups are not consistent.
This behavior is not allowed in the Ul, and mismatches in either the user's access
rights or the component's access group restrictions may result in warning or error
messages during the upload, and may result in an incomplete upload.

Online Report Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings and filters for each report in the order
listed below. For a description of each report setting, see the Creating Online Reports within Accolade
topic in the online Help.

Important! Using the import and export tools to update configuration can resultin
unintended changes if information is missing or creates an error during the import process.
Sopheon recommends reviewing Importing and Exporting Configuration Best Practices in
the online help before making changes in a production environment.

¢ Report Settings

The Report Settings worksheet contains the settings for the reports being imported.

Accepted Values on

Column Name Additional Notes

Upload*
System Name | Alphanumeric Used for matching in the upload.
characters, If a report exists, its settings are changed with the
underscore values in the uploaded file.
If it is new, a unique system name exists in the file
when uploaded, a new report is created.
Display Name Any If blank, the report does not upload.
Category Alphanumeric If a new, unique category name exists in the file
characters when uploaded, a new category is created.
If left blank, the report is placed in the Default
category.
Subject Valid report subject Used for matching for upload.

System Name | system name If the Subject System Name specifies Project

Snapshot History, a value must be entered in the
Is Snapshot field on the Columns and Filters
worksheet.

If blank, the report does not upload.

Owner Valid user system ID |Use the format with which the user accessed
Accolade, such as domain\username or
username@domain.com.




Column Name

Accepted Values on
Upload*

Additional Notes

If you are uploading a new report, the downloaded
file can be changed to a new owner in order to
transfer initial ownership when loading the file. If
this field is left blank or has an invalid user ID
entered, the system will assign the user
completing the upload as the owner of the report.

If you are making changes to an existing report via
upload, the Owner column is ignored and will not
update.

If a downloaded report was created by a
user that has been deleted, this file will
reflect [None] as the report owner.

Additional Valid user system ID | Use the format with which the user accessed

Owners Accolade, such as domain\username or
username@domain.com.
Separate each additional owner by a pipe (| )
character.
Can be blank.

Roles Valid Accolade user | Separate each role by a pipe (| ) character.

role Can be blank.

Description Any Can be blank.

Override Yes, Y, True, 1, X* All other values are treated as No on upload.

Project

Filtering

Export Days Integers Can be blank.

Export Time Time value in Can be blank.

Export File Valid file path for the | Can be blank.

Path export to

Export File Alphanumeric Can be blank.

Name characters,

underscore**

Export Include | Yes,Y, True, 1, X* All other values are treated as No on upload.

Timestamp

Export File Excel If blank, the setting defaults to Excel.

Type Ccsv

Available to Yes, Y, True, 1, X* All other values are treated as No on upload.

Charts &

Reports




Column Name

Upload*

Accepted Values on

Additional Notes

Available to Yes, Y, True, 1, X* All other values are treated as No on upload.
Configuration
Transpose Yes, Y, True, 1, X* All other values are treated as No on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when entering
data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you upload the spreadsheet.

** Limited to characters betweena-z, A-Z, and 0 - 9, and the underscore ( _).

Columns and Filters

The Columns and Filters worksheet includes the report column settings of the reports being

imported.

Column Name

Accepted Values on

Additional Notes

Upload*

Report Alphanumeric Used for matching for upload.
System characters, If a report exists, its settings are changed with the
Name underscore™ values in the uploaded file.
Unique Valid reference table | Can be blank if Reporting Column Type is defined
Group system name as Standard or Metric.
System Valid matrix system
Name name
Reporting Standard The value is related to the Reporting Data Type
Column Reference Table value, and must match in terms of appropriate data
Type Metric types.

Matrix If blank, the report does not upload.

Calculated
Reporting String The value is related to the Reporting Column
Data Type Image Type value, and must match the column type.

List If blank, the report does not upload.

Number

Date

Boolean

ID

Multilist
Column Valid report column- Used for matching for upload.
System specific system If a report column exists, its settings are changed
Name name™* with the values in the uploaded file.

If a new, unique system name exists in the file when
uploaded, a new column is created.

Display Any Can be blank.




Column Name

Accepted Values on

Additional Notes

Upload*
Name
Sort Order Any number The field is set to 0 on upload if no value is entered
or the value is not a number.
Sort Yes, Y, True, 1, X* All other values are treated as No on upload.
Ascending
Property Aggregation Method Link is only available for the Project Name report
None column.
Avg Can be blank.
Min
Max
StDev
Sum
Date Mask
Excel Dates
Days
Months
Quarters
Years
Link
Column Any number Must be a unique value for each column included in
Order a report.
Display Yes, Y, True, 1, X* Set the value to No, N, False, 0 if the column is only
Column On used as a filter and not a report column. Otherwise,
Report setthe value to Yes, Y, True, 1, X and specify the
Filter ID if applicable.
All other values are treated as No on upload.
Filter ID Any number Must be a unique value for each filter included in a

report.

Can be blank if the report does not include filters
and the Display Column On Reportis setto Yes.




Column Name

Accepted Values on

Additional Notes

Upload*

Filter Type equal If a Filter ID is specified, the Filter Type must be
not equal defined. and values must be entered on the Filter
greater than Values worksheet.
less than Can be blank if the report does not include filters
?reater thanorequal | gn4 the Display Column On Report is set to Yes.

(o}

less than or equal to

is empty

is not empty

between

contains

does not contain

is one of

between days

between dates

days before

days after

Is Snapshot Yes, Y, True, 1, X* If the Subject System Name on the Report

Settings worksheet is set to Project Snapshot
History, this field determines if the metric or matrix
is part of the snapshot, and must have a value
entered. Otherwise, can be blank.
All other values are treated as No on upload.

Is Link Yes, Y, True, 1, X* All other values are treated as No on upload.

Formula A valid expression If Reporting Column Type is defined as

Calculated, the Formula must be defined for the
calculated column.

Otherwise, can be blank.

Data Format

For columns
containing dates:

Days
Months
Quarters
Years

Excel Dates
Timestamp

For columns
containing numbers:

#.(#)

Data Format only applies for columns that contain
date or number values and specifies how the data
displays when the report is run.

+ Date columns - If blank, the value defaults to
Excel Dates on upload.

¢ Number columns - If blank, the value defaults to
#;(#) on upload.




Column Name

Accepted Values on
Upload*

Additional Notes

B 1 (B )
St i (SH, )

Show

Yes, Y, True, 1, X*

All other values are treated as No on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when entering
data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you upload the spreadsheet.

** Limited to characters betweena-z, A-Z, and 0 - 9, and the underscore ( _).

Filter Values

The Filters Values worksheet includes the values of the filters defined on the reports being
imported. This worksheet can be blank if the reports do not include filters.

Column Name

Accepted Values on

Additional Notes

name or field code

Upload
Filter ID Any number Used for matching for upload.
If a filter exists, its settings are changed with the
values in the uploaded file.
If a new, unique system name exists in the file when
uploaded, a new filter is created.
Can be blank if the report does not include filters.
Filter Value Any number Can be blank if only one filter is included in the
Rank report.
Filter Value Text If the report includes filters and this field is blank, the
Type Field code filter does not upload.
Metadata
Metric
Current User
Filter Value Valid metric system If the Filter Type on the Columns and Filters

worksheet is defined as is one of, separate the
metric or field code system name values with a pipe (
| ) character.

If the Filter Type on the Columns and Filters
worksheet is defined as between, the worksheet
includes additional rows for each filter value.
Additionally, concatenate an integer to the field code
system name to further specify the field code. For
example, a gate date field code would include an
integer to specify if it is referencing gate date 1, 2, 3,
etc.

Can be blank.




Column Name

Accepted Values on
Upload

Additional Notes

Filter
Runtime
Filter

Yes, Y, True, 1, X*

All other values are treated as No on upload.

** Limited to characters betweena-z, A-Z, and 0 - 9, and the underscore ( _ ).

Access Groups

The Access Groups worksheet includes the access groups for the reports being uploaded or

downloaded.
Column Name Accepted Values on Additional Notes
Upload
Report Alphanumeric Used for matching for upload.
System characters, If a report exists, its settings are changed with the
Name underscore values in the uploaded file.
Access Valid access group Include a separate row for each access group.
Group system name

** Limited to characters betweena-z, A-Z, and 0 - 9, and the underscore ( _).

Matrix Join Definitions

The Matrix Join Definitions worksheet includes the join definitions for reports being uploaded or
downloaded that include multiple matrices. This worksheet can be blank if the reports do not
include multiple matrices.

Column Name

Accepted Values on

Additional Notes

Name

Upload

Report Alphanumeric Used for matching for upload.
System characters, If a report exists, its settings are changed with the
Name underscore values in the uploaded file.
Source Valid matrix system Used for matching for upload.
Matrix name Cannot be the same matrix referenced in the Target
System Matrix System Name field.
Name . . P

If the report contains matrices and this field is blank

or invalid, the definition does not upload.
Source Valid matrix metric Must be a metric that is included in the matrix
Matrix system name defined in the Source Matrix System Name field.
Metric If this field is blank or invalid, the definition does not
System upload.




Column Name Accepted Values on Additional Notes
Upload

Target Valid matrix system Used for matching for upload.
Matrix name Cannot be the same matrix referenced in the
System Source Matrix System Name field.
Name

If the report contains matrices and this field is blank

or invalid, the definition does not upload.
Target Valid matrix metric Must be a metric that is included in the matrix
Matrix system name defined in the Target Matrix System Name field.
Metric If this field is blank or invalid, the definition does not
System upload.
Name

** Limited to characters between a-z, A-Z, and 0 - 9, and the underscore (_).

Creating Project Portfolio Level Reports

Use metric and metadata filters to create a report with a portfolio view that pulls child linked project
values and is viewable within the parent project. Create portfolio level reports that use the related
system project ID relative metadata filter to roll up and view data across projects in a portfolio.
Configured portfolio reports allow you to create charts that visually display data representing the related
projects.

In the example of a portfolio below, Project A is linked to Project B - D by Child Relationship link types,
where Project A is the parent. Create a report with relative metadata filters of related system project

ID and related project link type name. These specific metadata filters allow the report to identify and
dynamically capture child project data. View the report from within project A to garner a portfolio view of
project B-D data. If the same report is viewed from within Project B, Project E and Project F data would

display.
If viewing a portfolio report in .
Project A, you will see Project PrOject A
B, C, and D report data. —

If viewing a portfolio report in e Child
Project B, you will see Project Project Prc C ( LU — projects of
E and F report data. —— | Project A
- n 71 child
P roje ctE P roje ctF J» projects of
Project B

To create portfolio views in Accolade:

Note: The following procedure assumes a hierarchical portfolio structure with Child
Relationship project link types. Adjust the filters according to link types to pull data


PROC_LinkingRelatedProjects.htm

from projects with different relationships.

1. Create a new report or edit an existing report, ensuring the Override Project Filtering check
box is selected on the report settings.

2. Click # inthe upper right corner to view the report details, and click the Selected Filters
section.

3. Select the Projects subject and expand the Project Related Projects group.
4. Add the following filters to the report:

¢ Related Project System Project ID

¢ Related Project Link Type Name

5. Forthe Related Project System Project ID filter, select the equals (=) operator and Metadata
from the associated drop-down. Enter System Project ID as the metadata value.

6. Forthe Related Project Link Type Name select the equals (=) operator and Text from the
associated drop-down. Select Member of as the filter qualifier.

Selected Columns | Selected Filters | Advanced Matrix Settings

Related Project System Project 1D Runtime F

ct 1D Runtime Filter
= v || Metadata v || System Project ID

Related Project Link Type Name Runtirme Filter
= w || Text w || Member Of A4

7. Click OK to save the filter selections and return to the report settings.

Click O] in the upper right corner to display a preview of the report contents prior to saving.
8. Click Save to save the report.

9. (Optional) Associate the report to a project via a layout or the project Reports page.

Notes:

¢ Todelete afilter from a report, display the report from the Charts & Reports page and

click #" to display the report columns. Click the Selected Filters section, and click 0 in
the corresponding filter row to delete it. Click OK to close the dialog and click Save to
save the changes to the report.


PROC_CreatingPageLayouts.htm

Creating Charts from Report Data Overview

Online reports created within Accolade can be used to create new or copy existing charts that represent
all or a portion of the data that is returned in the report. Charting options vary, and a wide variety of
charts are included so you can create the best visual representation of the data in your system as
possible.

Note: Line Chart By Columns has been removed as a chart option in Charts & Reports and Charts &
Reports Manager. Users are encouraged to utilize Line Chart Trends as an alternative option.

Using Accolade online report data, users with All Reporting Rights can create charts on the Charts &
Reports page. Administrators and Process Designers can set charts as available for sharing with other
users, and can add a chart to a pod within a layout to display on a project page or as a global link.

Creating Bar Charts Based on Report Data

Bar charts use bars to represent and compare categories of data in a format that can be displayed
horizontally or vertically. One axis will generally have numerical values, and the other will describe the
types of categories being compared. In bar charts, the user can cycle through different views, that is,
different categories of data to get a more comprehensive view of a portfolio's performance using the

cycle icon 0 .

Important! Select appropriate data types to render a meaningful chart. Numeric data types
will chart bars successfully. The system will not prevent you from selecting different data
types and will plot selected data as best as possible without error.

To create a bar chart based on report data:

1. From the Workspace menu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by

navigating to the System menu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:

¢ To add a new chart - Click Add New, select Chart from the drop-down list, and click the Bar
Chart |_| icon.
¢ To edit the details of an existing report - Click the name of the chart on the Charts &

Reports page and click f. to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.



3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field

Description

Name

Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.

System Name

Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category

Enter or select the group to which this chart belongs.

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.

» Leave this field blank to add to the Default category.

« Todefine a new category, select New Category and enter
the category name.

e Todelete a category, remove every item from the category.
Empty categories are deleted automatically.

Description

Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on the
Charts & Reports page.

Owners

Click [} and select the additional users who can edit the chart
details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.

« Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

« Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

» Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.




Field Description

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the chart
publicly available.

Field Description

Available to Charts & | Select this check box to make the chart publicly available for
Reports users to access and view the chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to Select this check box to make the chart available for use in

Configuration configuration.

Specific Roles Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration When either Available to check box is checked, access
Access Groups groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model (Available for existing charts) Click on the Process Model
Usage Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box



is selected, the chart will only be available to the assigned owners in their My
Charts & Reports section.

In the Report Source field, select the report that contains the data to include in the chart. Only
online reports created in Accolade are available for selection.

In the Grouping field, select the column from the report that represents the data and
measurement values to plot on the chart.

e (Optional) To use the column names as labels for each axis, select the Display Axis Label
option for one or both axes.

e (Optional) Inthe Number Format drop-down, select an option to indicate how values for the
selected grouping display.

In the Bar field, select the column from the report that represents the data and measurement
values to plot on the chart.

¢ The chart draws negative and positive data points as greater than or less than a zero-value
line. If charting only positive values, the chart draws bars as greater than zero.

¢ If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

e (Optional) To use the column names as labels for each axis, select the Display Axis Label
option for one or both axes.

e (Optional) To display grid lines for the vertical axis, select the Show Grid Lines option.
e (Optional) To display values on the bars in the chart, select Display totals.

e (Optional) Inthe Number Format drop-down, select an option to indicate how values for the
bars display.

In the Cycles field, select one or many cycles. Each cycle displays a different grouping of data
that the bars represent. The Grouping selection is automatically selected and cannot be
unselected.

Enter the following information to alter the chart display:

Field Description

Display Type Select whether the bars display horizontally or vertically. The
chart rotates according to the display type. Number formats
specified in the report will also rotate since they apply to the data
and not the axis.

If the contents of your report produces enough bars
that the labels along the horizontal axis overlap, select
the Rotate Horizontal Axis Text option to display the
labels at an angle instead of horizontally to prevent
overlapping.

Color Theme Select the color palette to assign to the bars.




Field Description

If plotting 10 or more data points, consider a color theme to
accommodate each value measurement. Themes 2-5 allow for
up to 20-25 plotted values.

10. (Optional) Add target lines to display on the chart.

11. (Optional) If you edited an existing chart, click S inthe upper right corner to view the new chart.

12. Click Save to save your changes and create the chart.

Example - Creating Bar Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of products over
the last several years. The user has created a Product Line Revenues Report for their report source,
and selected the Product Lines, Revenue, Region, and Year metrics to be included in the report.

To create a bar chart to display this information, the user has selected the Year for the Grouping value
and the Revenue as the Bar value. The bars represent the yearly sales values of various products.

To create a bar chart to display this information and cycle through the metrics for different chart views,
the user has selected the Year for the Grouping, the Revenue for the Bar, and the Product Lines,
Revenue, and Region as the Cycles values. The Product Lines in the report represent the business
units of Desktop, Tablets, Peripherals, Servers, and Mobile. The bars represent the yearly sales values

of the various products. Select the cycle icon W to view the different charts.
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Notes:

To delete a saved chart, display the chart from the Charts & Reports page, click V4 to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

Before creating the chart, the user selects the sort order of the data in the associated
report.

Use the Currency Symbol system parameter to specify the currency symbol that
displays in the Number Format field when creating charts and reports.



Creating Grouped Bar Charts Based on Report Data

Grouped bar charts use bars to represent and compare different categories of two or more sets of data
in a format that display horizontally or vertically. Because the categories are grouped and arranged side
by side, the grouped bar arrangement allows users to visually represent the differences inside a group.
The grouped bar chart can be used to showcase differences in the same category across groups.
Generally, in the chart, one axis has a value such as a product line, the other axis has numerical values
such as revenue, and the bar segments show categories to be compared. In grouped bar charts, the
user can cycle through different views, that is, different categories of data to get a more comprehensive

view of a portfolio's performance using the cycle icon C] .

Important! Select appropriate data types to render a meaningful chart. Numeric data types
will chart bars successfully. The system will not prevent you from selecting different data
types and will plot selected data as best as possible without error.

To create a grouped bar chart based on report data:

1. From the Workspace menu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the System menu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:

¢ To add a new chart - Click Add New, select Chart from the drop-down list, and click the
Grouped Bar Chart “_ icon.

¢ To edit the details of an existing report - Click the name of the chart on the Charts &

Reports page and click f. to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.

System Name Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.




Field

Description

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category

Enter or select the group to which this chart belongs.

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.

» Leave this field blank to add to the Default category.

» Todefine a new category, select New Category and enter
the category name.

» Todelete a category, remove every item from the category.
Empty categories are deleted automatically.

Description

Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on the
Charts & Reports page.

Owners

Click [} and select the additional users who can edit the chart
details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.

» Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

« Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

 Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the chart

publicly available.




Field

Description

Available to Charts &
Reports

Select this check box to make the chart publicly available for
users to access and view the chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to
Configuration

Select this check box to make the chart available for use in
configuration.

Specific Roles

Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration
Access Groups

When either Available to check box is checked, access
groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process Model
Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared

Charts & Reports section of the Charts & Reports page. If neither check box

is selected, the chart will only be available to the assighed owners in their My
Charts & Reports section.

In the Report Source field, select the report that contains the data to include in the chart. Only

online reports created in Accolade are available for selection.

In the Horizontal Axis field, select the column from the report that represents the data and
measurement values to plot on the chart.

¢ The chart draws negative and positive data points as greater than or less than a zero-value

line. If charting only positive values, the chart draws bars as greater than zero.

¢ If a column within the report contains a selected Aggregate value, the aggregation displays

automatically when the report column is selected to display in a chart.

¢ (Optional) To use the column name as a label for the axis, select the Display axis label

option.




e (Optional) Inthe Number Format drop-down, select an option to indicate how values for the
selected column display.

(Optional) In the Vertical Axis field, select the column from the report that represents the data
and measurement values to plot on the chart.

¢ The chart draws negative and positive data points as greater than or less than a zero-value
line. If charting only positive values, the chart draws bars as greater than zero.

¢ If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

¢ (Optional) To use the column name as a label for the axis, select the Display axis label
option.

e (Optional) Inthe Number Format drop-down, select an option to indicate how values for the
selected column display.

¢ The Bars field displays a drop-down list to select one column.

In the Bars field, the user can select one or more columns from the report that represent each
bar within a group.

¢ Ifthe user selected a Vertical Axis, then the user must select one column only from the
Column drop-down list. The chart renders by rows.

¢ Ifthe user did not select a Vertical Axis, then the user can select multiple columns from the
box. The chart renders by columns.

Enter the following information to alter the chart display:

Field Description
Bar Axis Units Enter text to display as the vertical axis label.
Cycle Segments Horizontal Axis and Bars determines how the cycles are
mapped on the chart.

Horizontal Axis uses the selected cycle as the basis for the
horizontal axis. Bars maps the selected cycle to the vertical
bars.

Cycles Select one or many cycles.

Each cycle displays a different column of data that the grouped
bars represent. The Horizontal Axis selection is automatically
selected and cannot be unselected.

Display Type Select whether the bars display horizontally or vertically. The
chart rotates according to the display type. Number formats
specified in the report will also rotate since they apply to the data
and not the axis.

If the contents of your report produces enough bars
that the horizontal axis labels overlap, select the
Rotate Horizontal Axis Text option to display the




Field

Description

labels at an angle instead of horizontally to prevent
overlapping.

Number Format

Select a number formatting option to indicate how values within
the chart are displayed.

Legend

Select where in the chart to display the key that identifies what
the colors in the chart represent.

After the chart renders, toggle a key label in the legend to hide
and show data without changing the underlying chart and report
configuration.

Color Theme

Select the color palette to assign to the bars.

If plotting 10 or more data points, consider a color theme to
accommodate each value measurement. Themes 2-5 allow for
up to 20-25 plotted values.

10. (Optional) Add target lines to display on the chart.

11. (Optional) If you edited an existing chart, click € inthe upper right corner to view the new chart.

12. Click Save to save your changes and create the chart.

Example - Creating Grouped Bar Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of products over

the last several years. The user has created a Product Line Revenues Report for their report source,
and selected the Product Lines, Region, Year, and Revenue metrics to be included in the report.

To create a grouped bar chart to display this information, the user has selected the Region for the
Horizontal Axis, the Revenue for the Vertical Axis, the Product Lines as the Bars value, and

Product Lines, Revenue, and Year as the Cycles values. The Product Lines in the report represent
the business units of Desktop, Mobile, Peripherals, Servers, and Tablets. The bars represent the sales

values of various products. Select the cycle icon W) to view the different charts. Toggle a key label in
the legend to hide and show data in the rendered chart.
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* Todelete a saved chart, display the chart from the Charts & Reports page, click }" to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

¢ Ifthe Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

¢ Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

« Before creating the chart, the user selects the sort order of the data in the associated
report.

¢ Use the Currency Symbol system parameter to specify the currency symbol that
displays in the Number Format field when creating charts and reports.

Creating Stacked Bar Charts Based on Report Data

Stacked bar charts use a single bar to represent multiple categories of data in a format that display
horizontally or vertically. Because the categories are arranged in a stack, the stacked bar arrangement
allows users to visually represent and compare total sizes of bars and relative differences in categories.
The stacked bar chart can be used to showcase when one category overtakes another. Generally, in



the chart, one axis has a value such as a product line, the other axis has numerical values such as
revenue, and the bar segments show categories to be compared. In stacked bar charts, the user can
cycle through different views, that is, different categories of data to get a more comprehensive view of a

portfolio's performance using the cycle icon C] .

Important! Select appropriate data types to render a meaningful chart. Numeric data types
will chart bars successfully. The system will not prevent you from selecting different data
types and will plot selected data as best as possible without error.

To create a stacked bar chart based on report data:

1. From the Workspace menu, select Charts & Reports.
To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by

navigating to the System menu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:

¢ To add a new chart - Click Add New, select Chart from the drop-down list, and click the
Stacked Bar Chart |E_ icon.
¢ To edit the details of an existing report - Click the name of the chart on the Charts &

Reports page and click f. to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.

System Name Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.
Category Enter or select the group to which this chart belongs.

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.




Field

Description

» Leave this field blank to add to the Default category.

» To define a new category, select New Category and enter
the category name.

e Todelete a category, remove every item from the category.
Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the chart.
This description helps other users identify the chart on the
Charts & Reports page.

Owners Click [} and select the additional users who can edit the chart

details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.

» Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

» Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

 Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the chart

publicly available.

Field

Description

Available to Charts &
Reports

Select this check box to make the chart publicly available for
users to access and view the chart.




Field Description

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to Select this check box to make the chart available for use in

Configuration configuration.

Specific Roles Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration When either Available to check box is checked, access
Access Groups groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model (Available for existing charts) Click on the Process Model
Usage Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box
is selected, the chart will only be available to the assigned owners in their My
Charts & Reports section.

In the Report Source field, select the report that contains the data to include in the chart. Only
online reports created in Accolade are available for selection.

In the Horizontal Axis field, select the column from the report that represents the data and
measurement values to plot on the chart.

¢ The chart draws negative and positive data points as greater than or less than a zero-value
line. If charting only positive values, the chart draws bars as greater than zero.

¢ |f a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

e (Optional) To use the column name as a label for the axis, select the Display axis label
option.

e (Optional) Inthe Number Format drop-down, select an option to indicate how values for the
selected column display.



7.

(Optional) In the Vertical Axis field, select the column from the report that represents the data
and measurement values to plot on the chart.

¢ The chart draws negative and positive data points as greater than or less than a zero-value
line. If charting only positive values, the chart draws bars as greater than zero.

¢ If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

e (Optional) To use the column name as a label for the axis, select the Display axis label
option.

e (Optional) Inthe Number Format drop-down, select an option to indicate how values for the
selected column display.

¢ The Bar Segments field displays a drop-down list to select one column.

In the Bar Segments field, the user can select one or more columns from the report that
correlate to the stacked sections of the bars.

« |fthe user selected a Vertical Axis, then the user must select one column only from the
Column drop-down list. The chart renders by rows.

¢ [fthe user did not select a Vertical Axis, then the user can select multiple columns from the
box. The chart renders by columns.

¢ Check one or both check boxes to display values.

¢ Select Stacked to 100% to display the bar segments as percentages of the whole
rather than integer values.

¢ Select Display totals to include the total value for the entire bar after the last segment.

Enter the following information to alter the chart display:

Field Description
Bar Axis Units Enter text to display as the vertical axis label.
Cycle Segments Horizontal Axis and Bars determines how the cycles are
mapped on the chart.

Horizontal Axis uses the selected cycle as the basis for the
horizontal axis. Bars maps the selected cycle to the bar
segments.

Cycles Select one or many cycles.

Each cycle displays a different segment of data that the stacked
bars represent. The Horizontal Axis selection is automatically
selected and cannot be unselected.

Display Type Select whether the bars display horizontally or vertically. The
chart rotates according to the display type. Number formats
specified in the report will also rotate since they apply to the data
and not the axis.

If the contents of your report produce enough bars that




Field

Description

the horizontal axis labels overlap, select the Rotate
Horizontal Text option to display the labels at an
angle instead of horizontally to prevent overlapping.

Number Format

Select a number formatting option to indicate how values within
the chart are displayed.

Legend

Select where in the chart to display the key that identifies what
the colors in the chart represent.

After the chart renders, toggle a key label in the legend to hide
and show data without changing the underlying chart and report
configuration.

Color Theme

Select the color palette to assign to the bars.

If plotting 10 or more data points, consider a color theme to
accommodate each value measurement. Themes 2-5 allow for
up to 20-25 plotted values.

10. (Optional) Add target lines to display on the chart.

11. (Optional) If you edited an existing chart, click S inthe upper right corner to view the new chart.

12. Click Save to save your changes and create the chart.

Example - Creating Stacked Bar Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of products over

the last several years. The user has created a Product Line Revenues Report for their report source,
and selected the Product Lines, Region, Year, and Revenue metrics to be included in the report.

To create a stacked bar chart to display this information and cycle through the metrics for different chart
views, the user has selected the Region for the Horizontal Axis, the Revenue for the Vertical Axis,

the Product Lines as the Bar Segments value, and Product Lines, Revenue, and Year as the
Cycles values. The Product Lines in the report represent the business units of Desktop, Tablets,

Peripherals, Servers, and Mobile. The bar segments represent the various products by category across

region and revenue over several years. Select the cycle icon CJ to view the different charts. Toggle a
key label in the legend to hide and show data in the rendered chart.
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To delete a saved chart, display the chart from the Charts & Reports page, click f to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

Before creating the chart, the user selects the sort order of the data in the associated
report.

Use the Currency Symbol system parameter to specify the currency symbol that
displays in the Number Format field when creating charts and reports.



Creating Bubble Charts Based on Report Data

Bubble charts (also known as bubble plots) are multi-dimensional graphs that are a cross between a
scatter plot and a proportional area chart, and can be useful for comparing the relationships between
projects in multiple dimensions. Data points are plotted against a horizontal and vertical axis, and then
have additional data values represented by the size and color of the bubble. In bubble charts, the user
can cycle through different views, that is, different categories of data to get a more comprehensive view

of a portfolio's performance using the cycle icon W] .

Important! Select numeric data types for Bubble Represents values to render a
meaningful chart. The system will not prevent you from selecting different data types and will
plot selected data as best as possible without error.

To create a bubble chart based on report data:
1. From the Workspace menu, select Charts & Reports.
To narrow the list, search by the chart name or category.
Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the System menu and selecting Content Sources > Charts & Reports
Manager.
2. Do one of the following:

¢ To add a new chart - Click Add New, select Chart from the drop-down list, and click the
Bubble Chart L@ icon,

¢ To edit the details of an existing report - Click the name of the chart on the Charts &

Reports page and click :“?. to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.

System Name Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category Enter or select the group to which this chart belongs.




Field

Description

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.

« Leave this field blank to add to the Default category.

» Todefine a new category, select New Category and enter
the category name.

» Todelete a category, remove every item from the category.
Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the chart.
This description helps other users identify the chart on the
Charts & Reports page.

Owners Click [} and select the additional users who can edit the chart

details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.

» Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

» Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

» Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the chart

publicly available.




Field

Description

Available to Charts &
Reports

Select this check box to make the chart publicly available for
users to access and view the chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to
Configuration

Select this check box to make the chart available for use in
configuration.

Specific Roles

Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration
Access Groups

When either Available to check box is checked, access
groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process Model
Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared

Charts & Reports section of the Charts & Reports page. If neither check box

is selected, the chart will only be available to the assighed owners in their My
Charts & Reports section.

In the Report Source field, select the report that contains the data to include in the chart. Only

online reports created in Accolade are available for selection.

In the Horizontal Axis and Vertical Axis fields, select the columns from the report that
represent the data and measurement values to plot on the chart.

e (Optional) To use the column names as labels for each axis, select the Display Axis Label

option for one or both axes.

e (Optional) To display grid lines for the horizontal and vertical axis, select the Show Grid

Lines option.

¢ (Optional) Select the Rotate Horizontal Axis Text option to display the labels at an angle

instead of horizontally to prevent overlapping.




¢ (Optional) Inthe Number Format drop-down, select an option to indicate how values on the
axis are displayed.

e (Optional) In Scale Control, change the scaling and size of the displayed chart by selecting
one of the following options:

¢ Select Automatic to set the chart range minimum and maximum values displayed in the
chart based on the data ranges in the report.

¢ Select Custom to manually set the chart Range Minimum and Range Maximum values
displayed in the chart.

7. Select the following information to define what the bubbles within the chart represent:

Field Description
Bubble Size Select a number metric from the report that determines the size
of each bubble in the chart.
Number Format Select how values display within the tooltip for the bubbles in the
chart.
Bubble Represents Select the information that displays within the tooltip for the

bubbles in the chart.
Selecting [None] displays only the bubble's value in the tooltip.

Bubble Color Select the column that determines what each color represents in
the chart.
Bubble Opacity Select how solid to display the bubbles in the chart.

Using a smaller value displays the bubbles less opaque, and can
make each easier to see if bubbles overlap in the chart.

Cycles Select one or many cycles. Each cycle displays a different
grouping of data that the bubbles represent.

The Bubble Color selection is automatically selected and cannot
be unselected.

Color Theme Select the color palette to assign to the bubbles in the chart.

Legend Select where in the chart to display the key that identifies what
the bubble colors in the chart represent.

After the chart renders, toggle a key label in the legend to hide
and show data without changing the underlying chart and report
configuration.

8. (Optional) If you edited an existing chart, click S inthe upper right corner to view the new chart.

9. Click Save to save your changes and create the chart.

Example - Creating Bubble Charts in Accolade

For example, a user wants to review and compare the financial reward and customer benefit by region
for a portfolio of products over the last several years. The user has created a Product Line Revenues



Report for their report source, and selected the Product Lines, Region, Revenue, Year, Financial
Reward, and Customer Benefit metrics to be included in the report.

To create a bubble chart to display this information and cycle through the metrics for different chart
views, the user has selected:

* Horizontal Axis - Customer Benefit
¢ Vertical Axis - Financial Reward

¢ Bubble Size - Revenue

¢ Bubble Represents - Region

¢ Bubble Color - Product Lines

¢ Cycles - Year and Region

The Product Lines in the report represent the business units of Desktop, Tablets, Peripherals, Servers,
and Mobile. The bubbles represent the various products by category across region and revenue over
several years. The bubble location on the chart shows the high customer benefit and financial reward in
the upper right corner and low values in the lower left corner to help you identify possible investments.

Select the cycle icon CJ to view the different charts. Toggle a key label in the legend to hide and show
data in the rendered chart.
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* To delete a saved chart, display the chart from the Charts & Reports page, click f' to



display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

Use the Currency Symbol system parameter to specify the currency symbol that
displays in the Number Format field when creating charts and reports.

Creating Line Chart Trends Charts Based on Report Data

Line Chart Trends charts are created by connecting a series of data points together with a solid line, and
layering multiple lines within one chart to display or analyze trends or patterns in several related sets of
data. In line chart trends, the user can cycle through different views, that is, different categories of data

to get a more comprehensive view of a portfolio's performance using the cycle icon W .

Important! Select appropriate data types to render a meaningful chart. Numeric data types
will chart lines successfully. The system will not prevent you from selecting different data
types and will plot selected data as best as possible without error.

To create a line chart trends chart based on report data:

From the Workspace menu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the System menu and selecting Content Sources > Charts & Reports
Manager.

Do one of the following:

¢ To add a new chart - Click Add New, select Chart from the drop-down list, and click the Line
Chart Trends Ilﬂ‘ icon.

¢ To edit the details of an existing report - Click the name of the chart on the Charts &

Reports page and click f. to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.

Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.



Field

Description

Name

Enter a name, up to 64 characters long, which identifies the

chart.

To display this name as the chart's title, select the
Display as title option.

System Name

Enter a unique, shorter name that identifies the chart in queries,

reporting views, field codes, and other places in Accolade.

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category

Enter or select the group to which this chart belongs.

Use categories to organize like charts together. For example,

you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.

« Leave this field blank to add to the Default category.

» Todefine a new category, select New Category and enter
the category name.

» Todelete a category, remove every item from the category.
Empty categories are deleted automatically.

Description

Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on the
Charts & Reports page.

Owners

Click [&Y and select the additional users who can edit the chart
details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.

» Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

» Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

» Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data




Field Description

rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the chart
publicly available.

Field Description

Available to Charts & | Select this check box to make the chart publicly available for
Reports users to access and view the chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to Select this check box to make the chart available for use in

Configuration configuration.

Specific Roles Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration When either Available to check box is checked, access
Access Groups groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model (Available for existing charts) Click on the Process Model
Usage Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box
is selected, the chart will only be available to the assigned owners in their My
Charts & Reports section.

5. Inthe Report Source field, select the report that contains the data to include in the chart. Only
online reports created in Accolade are available for selection.



In the Horizontal Axis section, make the following selections:
e (Optional) Enter a description in the Label field to display a label for the horizontal axis.

e (Optional) Select the Rotate Horizontal Axis Text option to display the labels at an angle
instead of horizontally to prevent overlapping.

e (Optional) Select the Show Grid Lines option to display grid lines for one or both axes.
e (Optional) Select the Start at Zero option to display the data range along the horizontal axis
in relation to 0.

When the Start at Zero check box is not selected, the data range for the horizontal
axis will be determined by the lowest and highest available data values.

For example, you have data points that are all between the values of 6 and 10 that are being
graphed along the horizontal axis. Selecting the Start at Zero option will display a graph that
displays the value range of 0 to 10 along the horizontal axis to show the relation of the data to
the origin. If Start at Zero is not selected, the graph will display the value range of 6 to 10
along the horizontal axis.

e (Optional) Inthe Number Format drop-down, select an option to indicate how values on the
axis are displayed.

¢ Inthe Column drop-down list, select the column from the report that represents the data and
measurement values to plot on the horizontal axis of the chart.

« If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

In the Vertical Axis section, make the following selections:
e (Optional) Enter a description in the Label field to display a label for the vertical axis.
e (Optional) Select the Show Grid Lines option to display grid lines for one or both axes.

e (Optional) Inthe Number Format drop-down, select an option to indicate how values on the
axis are displayed.

¢ Select the Lines columns from the report that represent the data and measurement values to
plot on the vertical axis of the chart.

« If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

(Optional) In the Group By field, select columns from the report to apply line groupings to the
data presented in the graph.

Adding additional Group By selections introduces more lines to your display which
may impact chart use.
(Optional) Select the Display Point Marker check box to display the grid points.

In the Cycles field, select one or many cycles. Each cycle displays a different grouping of data
that the lines represent. The Horizontal Axis selection is automatically selected and cannot be



unselected.

11. Enter the following information to alter the chart display:

Field Description
Style Select whether to display lines only, or lines with fill below.
Legend Select where in the chart to display the key that identifies what

the colors in the chart represent.

After the chart renders, toggle a key label in the legend to hide
and show data without changing the underlying chart and report
configuration.

Color Theme Select the color palette to assign to the bars.

If plotting 10 or more data points, consider a color theme to
accommodate each value measurement. Themes 2-5 allow for
up to 20 plotted values.

12. (Optional) If you edited an existing chart, click € inthe upper right corner to view the new chart.

13. Click Save to save your changes and create the chart.

Example - Creating Line Chart Trends Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of products over
the last several years. The user has created a Product Line Revenues Report for their report source,
and selected the Product Lines, Region, Year, and Revenue metrics to be included in the report.

To create a line trends chart to display this information and cycle through the metrics for different chart
views, the user has selected the Year for the Horizontal Axis Label, the Product Lines as the
Column value, the Revenue for the Vertical Axis Label, the Revenue for the Lines, the Region for
the Group By value, and Revenue, Region, and Year as the Cycles values. The Product Lines in the
report represent the business units of Desktop, Tablets, Peripherals, Servers, and Mobile. The line
segments represent the various products by category across region and revenue over several years.

Select the cycle icon 0 to view the different charts. Toggle a key label in the legend to hide and show
data in the rendered chart.
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Notes:

* Todelete a saved chart, display the chart from the Charts & Reports page, click .f to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

¢ Ifthe Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

¢ Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

¢ Use the Currency Symbol system parameter to specify the currency symbol that
displays in the Number Format field when creating charts and reports.

Creating Pie Charts Based on Report Data

Pie charts present categories of data as slices of a pie, where each category is represented as a
percentage of the whole value of the chart. In pie charts, the user can cycle through different views, that
is, different categories of data to get a more comprehensive view of a portfolio's performance using the

cycle icon C] .



Important! Select numeric data types for the Slice Represents values to render a
meaningful chart. The system will not prevent you from selecting different data types and will
plot selected data as best as possible without error.

To create a pie chart based on report data:

1. From the Workspace menu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the System menu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:
¢ To add a new chart - Click Add New, select Chart from the drop-down list, and click the Pie
Chart t' icon.

¢ To edit the details of an existing report - Click the name of the chart on the Charts &

Reports page and click .f to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.

System Name Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category Enter or select the group to which this chart belongs.

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.

» Leave this field blank to add to the Default category.

» Todefine a new category, select New Category and enter
the category name.

» Todelete a category, remove every item from the category.




Field

Description

Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the chart.
This description helps other users identify the chart on the
Charts & Reports page.

Owners Click [} and select the additional users who can edit the chart

details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.

» Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

» Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

 Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the chart

publicly available.

Field Description

Available to Charts & | Select this check box to make the chart publicly available for

Reports users to access and view the chart.
Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to Select this check box to make the chart available for use in

Configuration configuration.




Field

Description

Specific Roles

Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration
Access Groups

When either Available to check box is checked, access
groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process Model
Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box
is selected, the chart will only be available to the assigned owners in their My
Charts & Reports section.

5. Inthe Report Source field, select the report that contains the data to include in the chart. Only
online reports created in Accolade are available for selection.

6. Select the following information to define the slices within the pie chart and how they display:

Field

Description

Slice Represents

Select the data column that contains the row items that the slices
in the pie represent.

Slice Size

Select the numeric data column that determines the size of the
slices in the pie.

Cycles

Select one or many cycles.

Each cycle is a data column that contains the row items that the
slices in the pie represent. The Slice Represents selection is
automatically selected and cannot be unselected.

Slice Name

Select to include the name of the pie slice as part of the slice's
label.

Slice Value or Slice
Percentage

Select whether to label the pie slices by value or percentage of
the pie included in the slice.

You can select one or both, or select neither to display the slices
with no values.




7. Select the following attributes to define the pie chart's style:

Field Description

Doughnut Displays the pie with an empty space in the middle.

Exploded Displays the pie with space between each piece.

Number Format Select a number formatting option to indicate how the values in
the chart are displayed.

Color Theme Select the color palette to assign to the pie sections of the chart.

If plotting 10 or more data points, consider a color theme to
accommodate each value measurement. Themes 2-5 allow for
up to 20-25 plotted values.

Legend Select where in the chart to display the key that identifies what
the colors in the chart represent.

After the chart renders, toggle a key label in the legend to hide
and show data without changing the underlying chart and report
configuration.

8. (Optional) If you edited an existing chart, click Sin the upper right corner to view the new chart.

9. Click Save to save your changes and create the chart.

Example - Creating Pie Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of products over
the last several years. The user has created a Product Line Revenues Report for their report source,
and selected the Product Lines, Region, Year, and Revenue metrics to be included in the report.



For example, a user wants to review and compare last year's sales revenue numbers for several
projects. The user has created a Sales Performance report for their chart report source, and selected
the Project Name and Sales Year 1 metrics to be included in the report.

To create a pie bar chart to display this information and cycle through the metrics for different chart
views, the user has selected the Product Lines for the Slice Represents, the Revenue for the Slice
Size, and the Region, Year, and Revenue as the Cycles values. The Product Lines in the report
represent the business units of Desktop, Tablets, Peripherals, Servers, and Mobile. The slices
represent the various products by category across region and revenue over several years. Select the

cycle icon W] to view the different charts. Toggle a key label in the legend to hide and show data in the
rendered chart.

To create a pie chart to display this information, the user has selected Project Name as the Slice
Represents value, and Sales Year 1 as the Slice Size value, to create slices that represent each
project's sales revenue as a portion of the company's overall sales total.
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Notes:

« Percentages in pie charts truncate after the first decimal place therefore the total may not
always equal 100%. For example, 27.786% will display as 27.7%.

¢ Negative values are not included in the pie chart.

* To delete a saved chart, display the chart from the Charts & Reports page, click V4 to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

» Ifthe Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.



¢ Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

« Before creating the chart, the user selects the sort order of the data in the associated
report.

Creating Radar Charts Based on Report Data

Radar charts are multi-dimensional graphs that display data values based on a shared center axis, and
can be useful for comparing properties of a single component, or for performance analysis and
determining when one variable is performing differently than the rest.

Important! Select spokes with numeric data types to render a meaningful chart. The system

will not prevent you from selecting different data types and will plot selected data as best as
possible without error.

To create a radar chart based on report data:

1. From the Workspace menu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by

navigating to the System menu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:

¢ To add a new chart - Click Add New, select Chart from the drop-down list, and click the
Radar Chart ©7 icon.

To edit the details of an existing report - Click the name of the chart on the Charts &

Reports page and click f. to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.




Field

Description

System Name

Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category

Enter or select the group to which this chart belongs.

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.

» Leave this field blank to add to the Default category.

» Todefine a new category, select New Category and enter
the category name.

» Todelete a category, remove every item from the category.
Empty categories are deleted automatically.

Description

Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on the
Charts & Reports page.

Owners

Click [&Y and select the additional users who can edit the chart
details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.

» Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

« Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

¢ Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.




4. (All optional, available in configuration only) Enter the following information to make the chart
publicly available.

Field Description

Available to Charts & | Select this check box to make the chart publicly available for
Reports users to access and view the chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to Select this check box to make the chart available for use in

Configuration configuration.

Specific Roles Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration When either Available to check box is checked, access
Access Groups groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model (Available for existing charts) Click on the Process Model
Usage Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box
is selected, the chart will only be available to the assigned owners in their My
Charts & Reports section.

5. Inthe Report Source field, select the report that contains the data to include in the chart. Only
online reports created in Accolade are available for selection.

6. Inthe Polygons field, select the column from the report that represents the data and
measurement values to plot on the chart.

¢ If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.



7. Inthe Spokes field, select the columns from the report that represent the data and measurement
values to plot as groupings or areas of the values.

8. Enter the following information to alter the chart display:

Field Description

Scale Control Select the scaling and size of the displayed chart.

» Select Automatic to set the chart range minimum and
maximum values displayed in the chart based on the data
ranges in the report.

» Select Custom to manually set the chart Range Minimum
and Range Maximum values displayed in the chart.

Number Format Select a number formatting option to indicate how the values in
the chart are displayed.
Style Select how the polygon shapes charting the data display.

If you select Lines and Fill or Fill Only, select how solid to
display the shapes in the chart in the Polygon Opacity field.
Using a smaller value displays the polygons less opaque, and
can make each easier to see if polygons overlap in the chart.

Legend Select where in the chart to display the key that identifies what
the colors in the chart represent.

After the chart renders, toggle a key label in the legend to hide
and show data without changing the underlying chart and report
configuration.

Color Theme Select the color palette to assign to the regions.

9. (Optional) If you edited an existing chart, click S inthe upper right corner to view the new chart.

10. Click Save to save your changes and create the chart.

Example - Creating Radar Charts in Accolade

For example, a user wants to review their portfolio of projects, and identify which ones continue to best
fit their company's overall strategy based on a set of current gate scores. The user has created a
Business Opportunity Report for their chart report source, and selected the Project Name, Market
Strategy Alignment, Customer Need, Market/Customer Attractiveness, Technical Strategy
Alignment, and Customer Benefit metrics to be included in the report.

To create a radar chart to display this information, the user has selected Project Name as the
Polygons value, and the Market Strategy Alignment, Customer Need, Market/Customer
Attractiveness, Technical Strategy Alignment, and Customer Benefit metrics as the Spokes
values to create shapes that compare the gate scores for various projects. Toggle a key label in the
legend to hide and show data in the rendered chart.



Notes:

* Todelete a saved chart, display the chart from the Charts & Reports page, click .f to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

¢ Ifthe Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

¢ Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

Adding Target Lines to Bar Charts

In order to characterize Accolade data more completely, it can be helpful to include a threshold line or
target value indicators to your chart. Bar charts include an option to display and hide target data for a
project or portfolio. Users can add target lines to grouped, stacked, and vertical bar charts to visually
represent a benchmark line and add context for the viewer. Adding interpretation to the data
visualization helps the viewer understand the information being presented in the chart.

To add target lines to a bar, grouped bar, or stacked bar chart:

1. From the Project > Charts & Reports page, click the name of the chart and click 4 to edit the
chart details.

2. Inthe Target Line Report Source field, select the online report to be referenced.



The Target Line Report Source does not have to be the same report as used for
the chart's Report Source. If the Report Source and the Target Line Report
Source are different reports, the values in the Target Line Report Key column
should match the values in the Grouping column.

3. Inthe Target Line Report Key and Target Line Report Value fields, select the report columns
from the selected source above that will be referenced to create target lines.

The Target Line Report Value controls what values the targets lines display in the chart.

¢ Ifthe Target Line Report Source column selected contains rows with unique values, the
Target Line Report Value will display the relative metric value as the target line.

¢ Ifthe Target Line Report Source column selected contains rows with duplicate values, the
target line will display as the aggregated totals of the Target Line Report Value metric values
from each row of data.

¢« When Cycle Segments is set to Horizontal Axis, the target lines will only be applied to the
original value, as defined for the horizontal axis.

Examples 1 & 2 discuss how to create a chart with target lines using one or multiple chart sources, and
the Target Line Report Source column contains unique values per project. Example 3 discusses how to
create a chart with target lines using aggregated metric totals.

Example 1 - Bar Charts Using One Report Source

For example, a user has several different projects that are all reporting yearly sales numbers, and wants
to review how each project performed against their individual sales target. For the report, the user has
created a Project Sales Report that includes the Project Name, and selected the Total Sales and
Sales Forecast metrics to be included in the report.

Using the Project Sales Report as the source for both the chart and the target lines, make the following
selections for a bar chart:

¢ Forthe chart setup, select Project Name as the Grouping value and Total Sales as the Bar
value, to create bars that represent the total sales for each project.

« For the targets setup, select Project Name as the Target Line Report Key value and Sales
Forecast as the Target Line Report Value, to create target lines that represent the sales
targets for each project.

The user could include additional sales data metrics in the chart and report in order to create grouped
bar and stacked bar charts to represent additional comparison views.

Example 2 - Bar Charts Using Different Report Sources

Using the same scenario from Example 1, the user is again reviewing how each project performed
against their individual sales target. In this example, the user will still create a report to gather the yearly
sales numbers from the projects, however the sales targets are defined in a reference table stored in
Accolade, so they will need to create a second report to use this table information to create target lines.



For the chart report, the user has created a Project Sales Report that includes the Project Name, and
selected the Total Sales metric to be included in the report. For the target line report, the user has
created a Sales Reference Table report that uses the reference table data for its information source.

Using the Project Sales Report as the source for the chart, and the Sales Reference Table as the
source for the target lines, make the following selections for a bar chart:

¢ For the chart setup, select Project Sales Report as the Report Source, Project Name as the
Grouping value and Total Sales as the Bar value, to create bars that represent the total sales

for each project.

¢ Forthe targets setup, select Sales Reference Table as the Target Line Report Source,
Project as the Target Line Report Key value and Sales Goal as the Target Line Report
Value, to create target lines that represent the sales targets for each project.

As with the single source grouped bar and stacked bar examples, the user can include additional
metrics in their chart and reports in order to visually represent the comparisons.

Example 3 - Bar Charts Using Aggregated Metric Totals

In this scenario, the user has several regions that are being reviewed against their regional yearly sales
targets. There are multiple projects within each region, so the user needs to aggregate both the sales
numbers and the total sales forecast for each region. For the report, the user has created a Regional
Sales Report that includes data for all of the projects in the region, and selected the Sales Region,
Total Sales, and Projected Sales metrics to be included in the report.

Using the Regional Sales Report as the source for both the chart and the target lines, make the
following selections for a bar chart:

¢ For the chart setup, select Regional Sales Report as the Report Source, Sales Region as the
Grouping value and Total Sales as the Bar value, to create bars that represent the total sales
numbers for each region. Since there are multiple projects in each region, the bar will display the
aggregated Total Sales value.

¢ Forthe targets setup, select Regional Sales Report as the Target Line Report Source, Sales
Region as the Target Line Report Key value and Projected Sales as the Target Line Report
Value, to create target lines that represent the total sales targets for each region, Again since
there are multiple projects in each region, the target line will display the aggregated Projected
Sales value.

As with the previous examples, the user can include additional metrics in their chart and reports in order
to visually represent the comparisons.

Important! When adding targets to bar charts, keep the following guidelines in mind:

» Select appropriate data types and values to render a meaningful chart and targets.
The system will not prevent you from selecting different data types and will plot
selected data as best as possible without error.




e Targetlines can be turned on and off by clicking on the Targets legend within the
chart.

e Target lines are only valid for use in bar charts that are displayed vertically.

¢ In stacked bar charts, target lines will not display if Stacked to 100% is selected.

Notes:

* Todelete a saved chart, display the chart from the Charts & Reports page, click .f to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

¢ Ifthe Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

¢ Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

Importing and Exporting Accolade Charts

Accolade provides Administrators and Process Designers the ability to export charts settings and
configuration from one Accolade environment and import them into another Accolade environment. For
example, your company may have separate test and production environments or company branches
hosted in separate Accolade instances. Instead of having to recreate online charts in each environment,
download the information and import into a different environment.

The download exports the chart configuration information into a spreadsheet file with the parts of the
charts grouped into tabs.

To export chart settings:

1. From the System menu, select Content Source > Charts & Reports Manager.
2. Select the charts and reports that you want to download.

To narrow the list by chart name or system name, add the criteria to filter by in the appropriate
filter text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list. To download all
charts and reports, select All.

3. Click Download in the top right corner of the page.

Accolade downloads all configured charts and reports in four separate spreadsheet files within a
zip file, and saves it to a temporary internet files directory. Charts settings are downloaded to a
workbook titted CHART_Workbook.xIsx and reports are downloaded separately in a workbook
titted RPT_Workbook.xlsx. Save the file to a more accessible location.



Note: Only components to which you have view and/or edit configuration access group
rights will download. Components you can only view may be included in the file, but
you can only upload changes to areas to which you have explicit edit permission.

To import chart settings into Accolade:

Important! In order to successfully import a chart, the report source the chart is built upon
must exist in the environment prior to upload.

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any charts that you do not want to include in the upload from the spreadsheet and save
the file.

3. From the System menu, select Content Source > Charts & Reports Manager.
4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load. The file name must be prefixed with
'CHART _'"in order to successfully upload.

6. Click Upload File.

Accolade uploads the changes to the existing charts in the spreadsheet, and adds any new
charts with unique system names.

7. (Optional) Click Print to print the import results for your records.

Note: Components that are imported are subject to group configuration rules. The user may
assign components in a way that the configuration access groups are not consistent.
This behavior is not allowed in the Ul, and mismatches in either the user's access
rights or the component's access group restrictions may result in warning or error
messages during the upload, and may result in an incomplete upload.

Chart Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each chart in the order listed
below. For a description of each chart setting, see the individual chart topic links in in the Creating
Charts from Report Data Overview topic in the online Help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import process.
Sopheon recommends reviewing Importing and Exporting Configuration Best Practices in
the online help before making changes in a production environment.

¢ General Settings

The General Settings worksheet contains the settings for all charts being imported. The columns
correlate to the specific chart configuration fields upon chart creation.



Column

Accepted Values on Upload*

Additional Notes

Name
System Alphanumeric characters, underscore** Used for matching in
Name the upload.
If a chart exists, its
settings are changed
with the values in the
uploaded file.
If a new, unique
system name exists
in the file when
uploaded, a new
chart is created.
Name Any If blank, the chart
does not upload.
Chart Type | Sopheon.Accolade.Models.Domain.Charts.BarChart | If blank, the chart
Sopheon.Accolade.Models.Domain.Charts.BubbleC | does not upload.
hart
Sopheon.Accolade.Models.Domain.Charts.Grouped
BarChart
Sopheon.Accolade.Models.Domain.Charts.LineChart
ByColumns
Sopheon.Accolade.Models.Domain.Charts.LineChart
Trends
Sopheon.Accolade.Models.Domain.Charts.PieChart
Sopheon.Accolade.Models.Domain.Charts.StackedB
arChart
Sopheon.Accolade.Models.Domain.Charts.RadarCh
art
Report Valid online report system name If blank, the chart
Source does not upload.
Display Yes, Y, True, 1, X* All other values are
Title treated as No on
upload.
Category Alphanumeric characters If a new, unique

category name exists
in the file when
uploaded, a new
category is created.

If left blank, the chart
is placed in the
Default category.




Column
Name

Accepted Values on Upload*

Additional Notes

Description

Any

Can be blank.

Owners

Valid user system ID

Use the format with
which the user
accessed Accolade,
such as
domain\username or
username@domain.
com. Separate each
additional owner with
a pipe (| ) character.

If blank, the chart
does not upload.

Roles

Valid Accolade user role

Separate each role
with a pipe (| )
character.

Can be blank.

Available to
Charts &
Reports

Yes, Y, True, 1, X*

All other values are
treated as No on
upload.

Available to
Configurati
on

Yes, Y, True, 1, X*

All other values are
treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when entering
data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you upload the spreadsheet.

** Limited to characters betweena -z, A-Z, and 0 - 9, and the underscore (_).



* Bar Chart

The Bar Chart worksheet contains the settings for the bar charts being imported. The columns
correlate to the specific bar chart configuration fields.

Column Name

Accepted Values on

Additional Notes

Upload*
System Alphanumeric Used for matching in the upload.
Name characters, If a chart exists, its settings are changed with the
underscore™ values in the uploaded file.
If a new, unique system name exists in the file when
uploaded, a new chart is created.
Grouping Valid report column If blank, the chart does not upload.
system name
Display Yes, Y, True, 1, X* All other values are treated as No on upload.
Grouping
Axis Label
Bar Valid report column If blank the chart does not upload.
system name
Display Bar | Yes,Y, True, 1, X* All other values are treated as No on upload.
Axis Label
Show Grid Yes, Y, True, 1, X* All other values are treated as No on upload.
Lines
Display Type | Vertical If blank, the value defaults to Vertical on upload.
Horizontal
Rotate Yes, Y, True, 1, X* All other values are treated as No on upload.
Horizontal
Axis Text
Color Theme | Theme 1 If blank, the value defaults to Theme 1 on upload.
Theme 2
Theme 3
Theme 4
Theme 5
Target Line Valid online report Can be blank.
Report system name
Source
Target Line Valid report column Can be blank.
Report Key system name
Target Line Valid report column Can be blank.
Report Value | system name
Number #:(#) If blank, the value defaults to #;(#) on upload.
Format # HHE (# B
Horizontal St Bt (S# HHE)




Column Name

Accepted Values on

Additional Notes

Upload*
Axis
Number #:(#) Indicates how values within the chart are displayed.
Format Bars | ####(#,###) If blank, the value defaults to #;(#) on upload.
SH (1 #H#H#)
Display Vertical Can be blank.
Totals Horizontal

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when entering
data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you upload the spreadsheet.

** Limited to characters betweena -z, A-Z, and 0 - 9, and the underscore (_).

Pie Chart

The Pie Chart worksheet contains the settings for the pie charts being imported. The columns

correlate to the specific pie chart configuration fields.

Column Name

Accepted Values on
Upload*

Additional Notes

System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a chart exists, its settings are changed with the

values in the uploaded file.

If a new, unique system name exists in the file when

uploaded, a new chart is created.

Slice
Represents

Valid report column
system name

If blank, the chart does not upload.

Slice Size

Valid report column
system name

If blank, the chart does not upload.

Slice Name

Yes, Y, True, 1, X*

All other values are treated as No on upload.

Slice Value

Yes, Y, True, 1, X*

All other values are treated as No on upload.

Slice
Percentage

Yes, Y, True, 1, X*

All other values are treated as No on upload.

Doughnut

Yes, Y, True, 1, X*

All other values are treated as No on upload.

Exploded

Yes, Y, True, 1, X*

All other values are treated as No on upload.

Number
Format

#,(#)
3 (4 )
S it (S# )

If blank, the value defaults to #;(#) on upload.




Column Name

Accepted Values on
Upload*

Additional Notes

Color Theme

Theme 1
Theme 2
Theme 3
Theme 4
Theme 5

If blank, the value defaults to Theme 1 on upload.

Legend

None
Right
Left

If blank, the value defaults to None on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when entering
data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you upload the spreadsheet.

** Limited to characters between a-z, A-Z, and 0 - 9, and the underscore (_).




* Bubble Chart

The Bubble Chart worksheet contains the settings for the bubble charts being imported. The
columns correlate to the specific bubble chart configuration fields.

Column Name Accepted Values on Additional Notes
Upload*
System Alphanumeric Used for matching in the upload.
Name characters, If a chart exists, its settings are changed with the
underscore™ values in the uploaded file.
If a new, unique system name exists in the file when
uploaded, a new chart is created.
Horizontal Valid report column If blank, the chart does not upload.
Axis system name
Display Yes, Y, True, 1, X* All other values are treated as No on upload.
Horizontal
Axis Label
Show Yes, Y, True, 1, X* All other values are treated as No on upload.
Horizontal
Grid Lines
Rotate Yes, Y, True, 1, X* All other values are treated as No on upload.
Horizontal
Axis Text
Horizontal Automatic If blank, defaults to Automatic.
Axis Scale Custom
Horizontal Any number If Horizontal Axis Scale is defined as Custom,
Axis Range enter a value for the chart range minimum value.
Min Otherwise leave blank.
Horizontal Any number If Horizontal Axis Scale is defined as Custom,
Axis Range enter a value for the chart range maximum value.
Max Otherwise leave blank.
Vertical Axis | Valid report column If blank, the chart does not upload.
system name
Display Yes, Y, True, 1, X* All other values are treated as No on upload.
Vertical Axis
Label
Show Yes, Y, True, 1, X* All other values are treated as No on upload.
Vertical Grid
Lines
Vertical Axis | Automatic If blank, defaults to Automatic.
Scale Custom




Column Name

Accepted Values on

Additional Notes

Upload*
Vertical Axis | Any number If Vertical Axis Scale is defined as Custom, enter
Range Min a value for the chart range minimum value.
Otherwise leave blank.
Vertical Axis | Any number If Vertical Axis Scale is defined as Custom, enter
Range Max a value for the chart range maximum value.
Otherwise leave blank.
Bubble Size Valid report column If blank, the chart does not upload.
system name
Bubble Valid report column Can be blank.
Represents system name
Bubble Color | Valid report column Can be blank.
system name
Bubble 0.1 If blank, the chart does not upload.
Opacity 0.2
0.3
0.4
0.5
0.6
07
0.8
0.9
Color Theme | Theme 1 If blank, the value defaults to Theme 1 on upload.
Theme 2
Theme 3
Theme 4
Theme 5

All the same color

Legend None If blank, the value defaults to None on upload.
Right
Left
Number #.(#) If blank, the value defaults to #;(#) on upload.
Format # i (# 7
Horizontal St i (SH# #HHE)
Axis
Number #:(#) If blank, the value defaults to #;(#) on upload.
Format # HHHE (8 B
Vertical Axis | $# ##H#;(S# #HHE)
Number #;(#) Indicates how values within the bubble's tooltips are
Format # HiHE (# 1) displayed.
Bubble Size | $###;(S# #HH)

If blank, the value defaults to #;(#) on upload.




* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when entering
data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you upload the spreadsheet.

** Limited to characters betweena-z, A-Z, and 0 - 9, and the underscore ( _).



¢ Grouped Bar Chart

The Grouped Bar Chart worksheet contains the settings for the grouped bar charts being
imported. The columns correlate to the specific grouped bar chart configuration fields.

Column Name Accepted Values on Additional Notes
Upload*
System Alphanumeric Used for matching in the upload.
Name characters, If a chart exists, its settings are changed with the
underscore™ values in the uploaded file.
If a new, unique system name exists in the file when
uploaded, a new chart is created.
Horizontal Valid report column If blank, the chart does not upload.
Column system name
Display Yes, Y, True, 1, X* All other values are treated as No on upload.
Grouping
Label
Horizontal
Bars Valid report column Separate each additional bar with a pipe (| )
system name character.
If Vertical Column has a value, then only one bar
segment allowed.
If blank, the chart does not upload.
Bar Axis Any Can be blank.
Units
Display Type | Vertical If blank, the value defaults to Vertical on upload.
Horizontal
Rotate Yes, Y, True, 1, X* All other values are treated as No on upload.
Horizontal
Axis Text
Number #,(#) Indicates how values within the chart are displayed.
Format Bars | ###(###) If blank, the value defaults to #;(#) on upload.
SH (1 #H#H#)
Legend None If blank, the value defaults to None on upload.
Right
Left
Color Theme | Theme 1 If blank, the value defaults to Theme 1 on upload.
Theme 2
Theme 3
Theme 4
Theme 5




Column Name Accepted Values on Additional Notes
Upload*

Target Line Valid online report Can be blank.

Report system name

Source

Target Line Valid report column Can be blank.

Report Key system name

Target Line Valid report column Can be blank.

Report Value | system name

Vertical Valid report column Can be blank.

Column system name

Display Yes, Y, True, 1, X* Can be blank.

Grouping

Label

Vertical

Number #:(#) If blank, the value defaults to #;(#) on upload.

Format # HHE (# B

Horizontal St Bt (S# #HHE)

Axis

Number #;(#) If blank, the value defaults to #;(#) on upload.

Format # i (# B

Vertical Axis | $# #HE (S# )

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when entering
data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you upload the spreadsheet.

** Limited to characters betweena -z, A-Z,and 0 - 9, and the underscore (_).

Stacked Bar Chart

The Stacked Bar Chart worksheet contains the settings for the stacked bar charts being
imported. The columns correlate to the specific stacked bar chart configuration fields.

Column Name Accepted Values on Additional Notes
Upload*
System Alphanumeric Used for matching in the upload.
Name characters, If a chart exists, its settings are changed with the
underscore values in the uploaded file.
If a new, unique system name exists in the file when
uploaded, a new chart is created.
Horizontal Valid report column If blank, the chart does not upload.
Column system name
Display Axis | Yes,Y, True, 1, X* All other values are treated as No on upload.
Label




Column Name

Accepted Values on

Additional Notes

Upload*
Horizontal
Bar Valid report column Separate each bar with a pipe (| ) character.
Segments system name If Vertical Column has a value, then only one bar
segment allowed.
If blank, the chart does not upload.
Stacked to Yes, Y, True, 1, X* All other values are treated as No on upload.
100%
Display Yes, Y, True, 1, X* All other values are treated as No on upload.
Totals
Bar Axis Any Can be blank.
Units
Display Type | Vertical If blank, the value defaults to Vertical on upload.
Horizontal
Rotate Yes, Y, True, 1, X* All other values are treated as No on upload.
Horizontal
Axis Text
Number #.(#) Indicates how values within the chart are displayed.
Format Bars | ###,(####) If blank, the value defaults to #;(#) on upload.
S# i, (S# #iH#)
Legend None If blank, the value defaults to None on upload.
Right
Left
Color Theme | Theme 1 If blank, the value defaults to Theme 1 on upload.
Theme 2
Theme 3
Theme 4
Theme 5
Target Line Valid online report Can be blank.
Report system name
Source
Target Line Valid report column Can be blank.
Report Key system name
Target Line Valid report column Can be blank.
Report Value | system name
Vertical Valid report column Can be blank.
Column system name
Display Axis Yes, Y, True, 1, X* Can be blank.
Label

Vertical




Column Name

Accepted Values on

Additional Notes

Upload*
Number #:(#) If blank, the value defaults to #;(#) on upload.
Format # HH (7, #HH)
Horizontal St Bt (S# #HHE)
Axis
Number #;(#) If blank, the value defaults to #;(#) on upload.
Format # HHE (7 #HH)
Vertical Axis | $# #HE, (S# )

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when entering
data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you upload the spreadsheet.

** Limited to characters betweena-z, A-Z, and 0 - 9, and the underscore ( _).

Radar Chart

The Radar Chart worksheet contains the settings for the radar charts being imported. The
columns correlate to the specific radar chart configuration fields.

Column Name Accepted Values on Additional Notes
Upload
System Alphanumeric Used for matching in the upload.
Name characters, If a chart exists, its settings are changed with the
underscore values in the uploaded file.
If a new, unique system name exists in the file when
uploaded, a new chart is created.
Polygons Valid report column If blank, the chart does not upload.
system name
Spokes Valid report column Separate each spoke with a pipe (| ) character.
system name If blank, the chart does not upload.
Spoke Axis Automatic If blank, defaults to Automatic.
Scale Custom
Spoke Axis Any number If Spoke Axis Scale is defined as Custom, enter a
Range Min value for the chart range minimum value.
Otherwise leave blank.
Spoke Axis Any number If Spoke Axis Scale is defined as Custom, enter a
Range Max value for the chart range maximum value.
Otherwise leave blank.
Number #:(#) If blank, the value defaults to #;(#) on upload.
Format # HHHE (B, #HHE)
S# HHE (S# #iH#)




Column Name

Accepted Values on
Upload

Additional Notes

Style

Lines Only
Lines and Fill
Fill Only

If blank, the value defaults to Lines Only on upload.

Opacity

0.1
0.2
0.3
0.4
0.5
0.6
07

0.8
0.9
1

If Lines Only is selected as the style, set the
opacity to 1 on upload.

Legend

None
Right
Left

If blank, the value defaults to None on upload.

Color Theme

Theme 1
Theme 2
Theme 3
Theme 4
Theme 5

If blank, the value defaults to Theme 1 on upload.

** Limited to characters betweena-z, A-Z, and 0 - 9, and the underscore ( _).

¢ Line Chart by Columns Chart

The Line Chart by Columns Chart worksheet contains the settings for the line charts being
imported. The columns correlate to the specific line chart by columns chart configuration fields.

Column Name Accepted Values on Additional Notes
Upload*
System Alphanumeric Used for matching in the upload.
Name characters,** If a chart exists, its settings are changed with the
underscore values in the uploaded file.
If a new, unique system name exists in the file when
uploaded, a new chart is created.
Lines Valid report column If blank, the chart does not upload.
system name
Horizontal Alphanumeric Can be blank.
Axis Title characters
Show Yes, Y, True, 1, X* All other values are treated as No on upload.
Horizontal




Accepted Values on

Column Name Additional Notes

Upload*
Grid Lines
Columns Valid report column Separate column names using a pipe (| ) character.
system name If blank, the chart does not upload.
Vertical Axis | Alphanumeric Can be blank.
Title characters
Show Grid Yes, Y, True, 1, X* All other values are treated as No on upload.
Lines
Rotate Yes, Y, True, 1, X* All other values are treated as No on upload.
Horizontal
Axis Text
Display Yes, Y, True, 1, X* All other values are treated as No on upload.
Point Marker
Style Lines Only If blank, the value defaults to Lines Only on upload.
Lines and Fill
Fill Only
Legend None If blank, the value defaults to None on upload.
Right
Left
Color Theme | Theme 1 If blank, the value defaults to Theme 1 on upload.
Theme 2
Theme 3
Theme 4
Theme 5
Number #,(#) If blank, the value defaults to #;(#) on upload.
Format # i (# 7
Horizontal St HHE (S# #iHE)
Axis
Number #:(#) If blank, the value defaults to #;(#) on upload.
Format # HHE (# B

Vertical Axis | $# it (S# #HHE)

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when entering
data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you upload the spreadsheet.

** Limited to characters betweena -z, A-Z, and 0 - 9, and the underscore ( _).



¢ Line Chart Trends Chart

The Line Chart Trends Chart worksheet contains the settings for the line series charts being
imported. The columns correlate to the specific line chart trends chart configuration fields.

Column Name Accepted Values on Additional Notes
Upload*
System Alphanumeric Used for matching in the upload.
Name characters, If a chart exists, its settings are changed with the
underscore™ values in the uploaded file.

If a new, unique system name exists in the file when

uploaded, a new chart is created.
Horizontal Alphanumeric Can be blank.
Axis Label characters
Rotate Yes, Y, True, 1, X* All other values are treated as No on upload.
Horizontal
Axis Text
Show Yes, Y, True, 1, X* All other values are treated as No on upload.
Horizontal
Grid Lines
Start at Zero | Yes, Y, True, 1, X* All other values are treated as No on upload.
Horizontal #,(#) If blank, the value defaults to #;(#) on upload.
Number # i (# 7
Format S# #H, (S# HitH)
Horizontal Valid report column If blank, the chart does not upload.
Axis system name
Columns
Vertical Axis | Alphanumeric Can be blank.
Label characters
Show Yes, Y, True, 1, X* All other values are treated as No on upload.
Vertical Grid
Lines
Vertical #:(#) If blank, the value defaults to #;(#) on upload.
Number # #HiHE (# 7
Format S# 1, (SH 1)
Vertical Axis | Valid report column Separate column names using a pipe (| ) character.
Columns system name If blank, the chart does not upload.
Group By Valid report column Separate column names using a pipe (| ) character.
Columns system name If blank, the chart does not upload.
Display Yes, Y, True, 1, X* All other values are treated as No on upload.
Point Marker




Column Name

Accepted Values on
Upload*

Additional Notes

Line Style

Lines Only
Lines and Fill
Fill Only

If blank, the value defaults to Lines Only on upload.

Legend

None
Right
Left

If blank, the value defaults to None on upload.

Color Theme

Theme 1
Theme 2
Theme 3
Theme 4
Theme 5

If blank, the value defaults to Theme 1 on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when entering
data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you upload the spreadsheet.

** Limited to characters between a-z, A-Z, and 0 - 9, and the underscore (_).

Access Groups

The Access Groups worksheet includes the access groups for the charts being uploaded or

downloaded.
Column Name Accepted Values on Additional Notes
Upload
Chart Alphanumeric Used for matching for upload.
System characters, If a chart exists, its settings are changed with the
Name underscore values in the uploaded file.
Access Valid access group Include a separate row for each access group.
Group system name

** Limited to characters between a-z, A-Z,and 0 - 9, and the underscore (_).

Cycles

The Cycles worksheet includes the chart cycles for the charts being uploaded or downloaded.
The columns correlate to specific chart types to cycle through.

Column Additional
Name Accepted Values on Upload Notes
Chart Alphanumeric characters, underscore** Used for
System matching for
Name upload.



OVW_ViewChartsAndReportsOverview.htm

Column
Name

Accepted Values on Upload

Additional
Notes

If a chart
exists, its
settings are
referenced in
the uploaded
file.

If blank, no
cycles upload.

Chart
Type

Sopheon.Accolade.Models.Domain.Charts.BarChart
Sopheon.Accolade.Models.Domain.Charts.BubbleChart
Sopheon.Accolade.Models.Domain.Charts.GroupedBarChart
Sopheon.Accolade.Models.Domain.Charts.LineChartTrends
Sopheon.Accolade.Models.Domain.Charts.PieChart
Sopheon.Accolade.Models.Domain.Charts.StackedBarChart

If blank, the
referenced
chart does not
upload.

Cycles

References columns in the charts that are designated as a cycle.

Used for
matching for
upload.

If chart settings
exist, the
referenced
chartis in the
upload file.

If blank, no
cycles upload.

** Limited to characters betweena -z, A-Z,and 0 - 9, and the underscore ( _).

Exercises - Creating Online Reports

Try out what you have learned!

Create a report using the online report that includes all open projects

that started after a date of your choosing.

Limit the users that can edit the report configuration.
Set the report to download on Wednesday at 6:00 am.

Create a bar chart that represents aspects of the report.

Accolade Excel Reports Overview

Accolade Excel reports can be added to the Charts & Reports page within Accolade and/orto a
process model for availability within a project. These reports are built and viewable in Excel, provide




flexibility in formatting, and can be created using the Accolade Office Extensions add-in application. The
application provides an interface to create a data report based on Accolade data.

Creating Accolade Excel Reports using Accolade Office Extensions

With the Accolade Office Extensions add-in, anyone in your organization with All Reporting Rights can
create a report in Excel using the add-in.

Reports created via the Accolade Office Extensions add-in provides the following advantages:

¢ No SQL knowledge is required. You can select Accolade data directly from the report interface
without writing SQL queries.

¢ Reports can be refreshed when downloaded from Accolade to contain up-to-date information
and formatted for distribution or review, query-based tables cannot.

Use the Report Privacy Warning Text system parameter to add a notification
within the report to indicate the content is private or confidential, and should not be
forwarded to others.

The information below assumes you are using the Accolade Office Extensions add-in to create reports
and assumes you are familiar with basic Excel functionality. For more information about manipulating
the data in a report, see the online Help available from within the add-in.

To create an Accolade Excel report:

1. Open Excel and navigate to the Accolade menu in the Excel ribbon.
This allows Excel to pull data from Accolade into the report and allows reports to be created or
refreshed to display current Accolade information.

If necessary, connect to the appropriate server by clicking Server and entering the
server URL.
2. Click Data Reports and do one of the following:
¢ To add a new report - Click Add New.

* To create a report based on an existing report - Click |-.-—,: to copy the report.
¢ To edit an existing report - Click the name of the report to open it for editing.

3. Select a subject from the drop-down list, such as Projects or Users, to display the column sets
available within that subject.

4. Double-click or drag and drop the column names from the left side of the dialog to any area in the
Columns tab to include the column in the report.

e To search for a column, enter search criteria in the Find field after selecting the subject.

* Usethe and [=] options to expand or collapse the subject data sets in order to select
specific column options.



¢ Toinclude an entire column set, drag and drop the column set to the Columns tab.

¢ To change the column order of selected columns, drag and drop a column into a new location
within the list.

* Toremove a column, click O in the corresponding row.

5. (Optional) Refine the content of the report as necessary.

* Rename columns - Click in one or more selected columns and enter a new column name
that is more appropriate for the report you are creating.

¢ Set column sorting - Click = next to one or more selected columns to indicate whether the
column is sorted in ascending or descending order. If you select more than one column to
sort by, indicate the order in which the columns sort; 1 being the primary sort, 2 the
secondary sort, and so on.

* Determine column properties - For number and date columns, click Z or [ in the
Properties area to group data together by aggregation or select date formats. Select the
aggregate method or date format and click away to apply the changes. All selected
aggregate methods are added to the report columns list with the aggregate method
appended to the column name.

For example, to summarize the total costs for all projects within a brand, select Sum as the
aggregate value in a column that represents the total costs for a project.

¢ Add Count Column - If you select to summarize values within the report, click o Add
Count Column to add a column that shows how many rows of source data are combined in
the summary row.

You can order and rename the added column as you can other columns; however,
you can add only one Count column to the report.

¢ Add Calculated Column - Click (+] Add Calculated Column to add a column to the report
that displays a calculation based on other column data.

6. (Optional) On the Filters tab, double-click or drag and drop the column name from the left side of
the dialog to any area in the Filters tab to use it as filter criteria that data must match to be
included in the report.

7. (Optional) Onthe Report Details tab, add the following information:

Field Description
Report Name Enter a name which identifies the report.
Report Location Select one of the following options for the location to place the
report:

» Existing worksheet - Select this check box to add the report
to an existing worksheet that does not already contain a
report, and select the appropriate existing worksheet name
from the drop-down list.

* New worksheet - Select this check box to create and add the




Field Description

report to a new worksheet, and enter the name for the new

worksheet.
Override Project Select this check box to include the entire report set from within
Filtering a project.

The report will not filter to project-specific data when viewed
from within a project, and will display all projects in a portfolio
regardless of security.

Transpose Select this check box to transpose the column and row data
when the report is rendered.

8. Onthe Advanced Matrix Settings tab, if more than one matrix was selected in the report

columns, click + Add to add the matrix join definitions.
9. Click Done to apply your changes and generate the report.

10. Save the report to an accessible location.

Notes:

¢ Click Refresh Columns in the lower left of the dialog to refresh the columns. Any
columns modified in the Accolade application while the user is creating or editing the
report will be updated. Deleted columns will be removed from list of available columns
and will display red in the Columns tab and Filters tab. Delete the selections in red to
correct the report.

¢ To delete a saved report created in Excel, click Data Reports in the Accolade menu on

the Excel ribbon and click 0 next to the corresponding report. Deleting a report created
using the Accolade Office Extensions add-in deletes report data being pulled from
Accolade into the workbook. Deleting a report directly from the worksheet does not delete
the data associated with the report.

Adding Calculated Columns to Accolade Excel Reports

Reporting details can be contained in multiple sources within Accolade. To combined related data
values to be used for reporting or the creation of charts or presentations, users can create reports that
include calculated columns that calculate and/or display combined data, allowing users to manipulate
and analyze Accolade data values.

For example, a user may have several different project metrics that represent categories of project costs
such as Administrative, Operating, Marketing, etc. In order to calculate and display the sum of these
project costs within an Accolade report or chart, the user can include a calculated column in their report
setup.

iy
EXAMPLE
e Example



Writing a calculated column formula in Accolade is slightly different than writing an equation in math
class, or using formulas in Excel. The most notable difference is the use of the equal sign (=). For
example, if you want to add the numbers 3 and 2:

¢ In math class, the equation would read 3+2=, with a calculated value of 5.

¢ In Excel, formulas start with the equal sign, so it would look like =3+2. When entered, the value in
the selected cell would return as 5. If you wanted to add two cell values, it would look something
like =A1+B1 or =SUM(A1:B1). Assuming the values in A1 and B1 were 3 and 2 respectively, it
would return the value 5.

AutoSave (@ o) ) ~

File Home nsert Draw Page Layout Formulas Data Review Views [
Cl1 b I =A1+B1
A B C v E F G H |
1 3 2 | 5 _l <= this could also be entered as the formula =5UM[A1:B1)
2

¢ Inan Accolade Excel report created using the Accolade Office Extensions add-in, the equal sign
is assumed, so it does not need to be included in the formula field. If you wanted to add the
values of Column A and Column B, it would look like [Column A] + [Column B] or Sum
(IColumn A], [Column B]). Assuming the first row values of Column A and Column B were 3
and 2 respectively, it would return the value 5.

Example Report - Saved -

File Home Insert Draw Page Layout Formulas Data Review View

A1 T I Example Report
A B C D E

1 |Examp|e Report |
2
3 Project Name Column A Column B Sum of Columns A & B
4 Project Example 1 3 2 5
5 Project Example 2 4 9 13
6 Project Example 3 2 7 9
T

To add a calculated column to an Accolade Excel report:
Note: See below for a list of calculations that are currently supported for reporting.

1. Create a new report or open an existing report for editing.

2. Onthe Columns tab, ensure the columns to be used in the calculation are included in the report.



Report calculations are executed from left to right. In order for selected columns to
be used in a calculated column, they must a) be selected as a column for the
report, and b) be included before they are referenced by a calculated column (this
means they must appear to the left of the calculated column when displayed, or
above the calculated column when selecting columns in the report setup).

3. Click & Add Calculated Column.

The column is added with two fields - one for the display name for the column, and one for the
formula to be calculated.

4. Inthe left field, enter the column name to be displayed when the report is generated.

5. Inthe )( field, enter the formula to be calculated within the report.

When entering your formula, the columns are referenced by enclosing the column display name
inside of square brackets. In the example above, Column A is entered as [Column A].

6. Click f\ to select the appropriate datatype for the calculated column.

¢ Date - Select this option when you want the column data to display as a Date datatype, for
example when using the DateAdd function to project a future project date.

¢ Number - Select this option when you want the column data to display as a Number datatype,
for example when using the Sum function to combine the values of two or more columns of
expense values.

¢ String - Select this option when you want the column data to display as a String datatype, for
example when using the Concatenate function to display user name and functions combined
in one column.

7. (Optional) Drag and drop the calculated column to a new location within the list.

Note that while the calculated column cannot be displayed in the report until after its reference
columns are displayed, you can have calculated columns that are displayed between data
columns as necessary. Using the example above, after the Sum column we could add Column
C and Column D to the report and then add another calculated column, and so forth.

8. Finish setting up the report, as necessary.
9. Click Done to apply your changes and generate the report.

10. Save your changes to the report.

Available Formulas for Calculated Columns in Reporting

The following section details the operators and functions that are available for use when creating your
calculated column formulas.

Important! Note that the examples use "Column A", "Column B", and "Column C" to
generically refer to the display names of different columns that are included in the report
data.




Operators

Operators are process or mathematical parts of expressions, such as addition and multiplication, and
relationships such as greater than or less than. Use the operators below within your calculated column
expressions.

Operator Example

Additive and Subtractive Operators

+ (plus, plus sign) [Column A]+[Column B]

- (minus, dash) [Column A]-[Column B]

Multiplicative Operators

* (multiplied by, asterisk) [Column A]*5
/ (divided by, slash) [Column A)/[Column B]
% (mod, percent sign) [Column A]%10

Primary Operators

value (integers, text strings, ('this is a text string')

dates, functions)
While single quotes work for dates,

we recommend wrapping dates in
pound or hash signs instead to
ensure consistency of data types.
For example, (#2021-10-19#).

() (parentheses) 1000-(6*[Column A])

Relational Operators

= (equals) [Column A]=250

<> (does not equal) [Column A]<>[Column B]

> (greater than, angle bracket) | [Column A]>250

>= (greater than or equal to) [Column A]>=250

< (less than, angle bracket) [Column A]<500

<= (less than or equal to) [Column A]<=100

Logical Operators

or, || (double pipe) [Column A]<[Column B]||[Column A]<500

and, && [Column A]<[Column B]&&[Column A]<1000




Functions

The functions included in the calculated column formula determine in part what is returned in the
column. Use the functions described below within your calculated expressions to return data within a
calculated column.

For more information on the description or formatting for the calculations below, see Calculated Metric
Expressions Reference.

Function Example Formula
Abs Abs([Column A])
Acos Acos([Column A])
Asin Asin([Column A])
Atan Atan([Column A])
Avg Avg([Column A], [Column B], [Column C])
Ceiling Ceiling([Column A])
Concatenate Concatenate('text1',[Column A], 'text2', 'textN')
Contains Contains([Column A], 'My Blue Heaven', 2, 7)
Cos Cos([Column A))
DateAdd DateAdd('D', 5, [Column A])
DateDiff DateDiff('D',[Column A], [Column B])
DatePart DatePart('M', [Column A])
Exp Exp([Column A])
Find Find([Column A], 'My Blue Heaven', 2, 20)
First First([Column A], [Column B], [Column C])
Floor Floor([Column A])
IEEERemainder IEEERemainder([Column A], [Column B])
If If([Column A]>500, 'Go ahead', 'Stop")
In In([Column A], 1, 2, 3)
Join Join([Column A], [Column B], [Column CJ), ')
Length Length([Column A])
Log Log([Column A], 10)
Log10 Log10([Column A])
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Function Example Formula
Lower Lower([Column A])
LTrim LTrim([Column A])
Max Max([Column A], [Column B], [Column C])
Min Min([Column A], [Column B], [Column C])
Now Now()
Pow Pow([Column A], 2)
Replace Replace([Column A], 'Blue’, 'red")
Round Round([Column A], 2)
RTrim RTrim([Column A])
Search Search('blue’, [Column A], 5, 30).
Sign Sign([Column A])
Sin Sin([Column A])
Sqrt Sqrt([Column A])
SubString SubString([Column A], 4, 10)
Sum Sum([Column A], [Column B], [Column C])
Tan Tan([Column A))
Trim Trim([Column A])
Truncate Truncate([Column A])
Upper Upper([Column A])
Notes:

¢ To delete a calculated column from an Accolade Excel report, click Data Reports in the
Accolade menu on the Excel ribbon and click the name of the report to open it for editing.

Expand the Columns tab, and click in the corresponding calculated column row to
delete it. Click Done to apply your changes and generate the report and save your
changes to the report.

Adding Dynamic Filters to Accolade Excel Reports

Capture and filter report data using relative metric and metadata field codes to create dynamic reports
that display data according to defined filters within the report. Filtering reports based on relative metrics



and metadata field codes allows you to narrow the returned data set while still generating a higher level
view. Dynamic filters allow you to view a subset of data from within different projects.

Important! Ensure the Override project filtering check box is selected on the report
settings. This enables the report to include data across a subset of projects.

To add dynamic filters to an Accolade Excel report:

1. Create a new report, or open an existing report for editing.
2. Click and expand the Filters tab.

3. Toadd filters, double-click or drag and drop the column names from the left side of the dialog to
any area in the Filters tab.

¢ To search for a column to add as a filter, enter search criteria in the Find field after selecting
the subject.

¢ Toinclude an entire column set, drag and drop the column set to any area in the Filters tab.

If multiple filters are added to the report, data must meet ALL filter criteria to be
included in the report.

4. For each added filter, select the operator and filter criteria that report data must match to be
included.

The filter operators are dependent on the column selected to filter by, and generally include
options such as =, is empty, is one of, does not contain, and more.

The filter type must be selected from one of the following, and the following field identifies the
criteria to be met:

¢ Metadata - Enter the field code display name and select from the returned list. Ensure you
enter a valid query field code.

¢ Metric - Enter the metric display name and select from the returned list.
¢ Text - Enter or select a static string or numeric value such as a date.
¢ Current User - Filters the report to data only applicable to the user logged in and viewing the

report. Current User is only available for numeric or ID data type columns.

Type ahead to search for metrics and field codes when defining the filter criteria.
Only metrics and field codes that match the data type of the filter display for
selection. For example, if you select a date filter, you can only select date metrics
or field codes to define the relative filter.

For example, to create a report that returns a list of deactivated users, filter on the User Active
column to return only users where the active flag is set to No.
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5. (Optional) Select the Prompt on Refresh check box to prompt the user to review and/or update
the filters when refreshing the data in the report.

6. Finish setting up the report, as necessary.
7. Click Done to apply your changes and generate the report.

8. Save your changes to the report.

Notes:

« To delete afilter from an Accolade Excel report, click Data Reports in the Accolade menu
on the Excel ribbon and click the name of the report to open it for editing. Expand the

Filters section, and click 0 in the corresponding filter row to delete it. Click Done to
apply your changes and generate the report, and save your changes to the report.

¢ Long string and multi-select list metrics are currently not supported for use as metric
filters.

Adding Multiple Matrices to Accolade Excel Reports

Reporting details can be contained in multiple sources within Accolade. To consolidate data into a
single source to be used for reporting or the creation of charts or presentations, users can create reports
to combine the data. Information from more than one project matrix can be pulled into a report by
including a common value that is included in the sources, for example, using a Department or Region
metric or a common Row ID.

In addition to selecting the matrix and metric columns to be included in the report, users must create join
statements that define how the matrix information is related.

Common
Value

Matrix A Matrix B



To add multiple matrices to an Accolade Excel report:

1.
2.

Create a new report or open an existing report for editing.

On the Advanced Matrix Settings tab, select the matrices and metrics to be included in the
report.

Click L+ Add to add the matrix join statements.

In each side of the dialog, select one of the matrices from the drop-down list, and select an option
to use as the common value to join the matrices.

The two selected matrices must be different, but the matrix/metric combination can be any
combination of metrics or row IDs, as long as the selected metrics share a common value and
are of the same data type.

Selecting a metric will define it as the common value between the two matrices. Note that it can
be the same metric if it is used in both matrices, or it can be different metrics that will have the
same value in both matrices. In addition, a metric used as a common value does not need to be
added as a reporting column in order to be used to create the join statement.

Selecting Row ID will compare matrices by rows, for example Row 1 in Matrix A will be compared
with Row 1 in Matrix B, and so on. This can be used when there are no additional common values
in the two matrices, and the matrices have a direct line-by-line comparison.

/l} Caution! Selecting Row ID as a common value can cause inconsistencies in
reporting. Since assigned Row IDs are not visible within a matrix, report results
can be incorrect if rows have been deleted from a matrix or if there is a mismatch.

select Columns @ &~ X
|Projects v/
Find: |BE Selacted Columns  Selectad Filters | Advanced Matrix Settings
Matrix - Matrix 1
Merric A1 — I\'Mamx - Matrix 1 ~(metric a1 ~| = [Matrbx - Matrix2 v [ Metric -1 v I [x]
Metric A-2 -
Metric A-3 © add
Matrix - Matrix 2
Metric B-1
Metric B-2
Metric B-3
—
Categorization . ) .
oTIC On each side of the dialog, select one matrix and a
bl ;';j:”:d related matrix that defines the relationship between
Financial the matrices in order to generate the report.

Financial Analysis
Financials

ldea

Initalized

Innovatien Planning
LineChart

NPD Metrics

Pattern Coverage

Post Launch Review Flan

Post Launch Review Scorecard

Ranking Data

Scorecards

[ ok || cancel

Repeat steps 3-4 to add additional matrix join statements as necessary.

All'included matrices must have at least one related join statement, but a matrix can be
referenced in more than one statement. For example, if you choose to include metrics from
Matrix A, Matrix B, and Matrix C, you would need to create two statements to join the information.



You could create a statement that relates A to B, and one that relates B to C, or you could have a
statement that relates A to B, and one that relates A to C.

6. Finish setting up the report, as necessary.

7. Click Done to apply your changes and generate the report.

Note: [EMPTY] or blank cells in your report may indicate a mismatch in the common value
linking the matrices. If the project value referenced in the join statement is not defined
in one of the matrices, for example if there is not a matching value in both matrices, or
a matrix contains empty rows, the report will return partial or full rows that contain
[EMPTY] values.

et
S Example
For example, a user has two different matrices that contain information related to vendor contracts for
their projects, and needs to create a report containing relevant information from both matrices. They
have a matrix named Contract Information, which contains the start date and duration of the specific
contracts, and a second matrix named Contract Cost, which contains the costs related to the specific
contracts.

To pull this information into one report, the user has added the related columns to the Columns tab, and
created a join statement in the Advanced Matrix Settings tab that links the two matrices using the
Contract ID metric that is a member of both matrices.

select Columns @ » X
|Projects ~|
Find: |mEE Selacted Columns  Selectad Filters | Advanced Matrix Settings
Mt - Cariract Cost

CarwractID - - — -

oneract _bl\Mamx—Ccnlract]nfclmat\un +|[contract 1D v = [Matrix - Contract Cost ~|[contract 10 ~] I [x]

One-Time Costs : /

Cansract Costs © Add

Matrix - Contract Information
Contract ID
Contract Start Date

Contract Duration

Bugget
Categorization
DTIC

DTIC Funding

DTIC Required
Financial

Financial Analysis
Financials

ldea

Initalized
Innovation Planning
LineChart

NPD Metrics
Pattern Caverage

Post Launch Review Plan

Post Launch Review Scorecard

Freject Attributes

Ranking Data

Scerecards

(o) ((Goneel)

Once the user enters the remaining report details and clicks Done, the following report is generated.



RN T ST SR

N (= (o

13

s

Contract Information Matrix Contract Cost Matrix

A B Cl D E Fl G

Contract Details { \ { \
Project Name Contract ID  Contract Start Date Contract Duration Contract ID One-Time Costs Contract Costs
Emotion Electronics A100 6/1/2019 12 Month Term A100 S 2,100.00 $ 12,500.00
Emotion Electronics  |A101 6/1/2020 12 Month Term [EMPTY] S - s -
Emotion Electronics  [[EMPTY] 1/1/1900 [EMPTY] A110 S 1,400.00 $ 12,500.00
Smith Marketing 28501 6/1/2018 12 Month Term 28501 S 8,400.00 $ 10,125.00
Smith Marketing 34886 6/1/2019 12 Month Term 34886 S 1,850.00 $ 12,750.00
Express Services 001684-0197 10/21/2019 24 Month Term 001684-0197 S - S 1,840.00
ACME Company AC1217 4/1/2018 12 Month Term AC1217 $ 2,500.00 $ 5,000.00
ACME Company AC1924 4/1/2019 12 Month Term AC1924 S - S 5,300.00
ACME Company AC2101 4/1/2020 12 Month Term AC2101 S 500.00 $ 6,150.00
Fred's Grocery [EMPTY] 1/1/1900 [EMPTY] [EMPTY] S - S -
Fred's Grocery [EMPTY] 1/1/1900 [EMPTY] [EMPTY] S S

4

Contract Details ®

Note the following:

The Contract ID field is the common identifier included in both matrices, and used to connect the

releva

nt information.

Columns B-D contain information that is from the Contract Information matrix in the related projects.

Columns E-G contain information that is from the Contract Cost matrix in the related projects.

The highlighted sections below show two different scenarios that may indicate missing or incomplete

data.

Rows 5 & 6 of the report display [EMPTY] in some of the data cells, which indicates Contract IDs
values that are not found in both matrices. In row 5, the information for contract A101 is only
included in the Contract Information matrix, so the related Contract Cost matrix fields are
[EMPTY]. In row 6, the information for contract A110 is only included in the Contract Cost matrix,
so the related Contract Information matrix fields are [EMPTY].

Rows 13 & 14 display [EMPTY] cells in all of the data cells, which indicates that one or more of
the included matrices either does not have any rows added, or contains empty rows.

Note: Although the [EMPTY] returned values are an indicator of potential issues, the
mismatched values reported are dependent on the data type. String and list metrics
will display as [EMPTY]. As shown in the example below, a number metric will display
0, and a date metric will represent the default 1/1/1900 date.
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1 | Contract Details
2
3 |Project Name ContractID  Contract Start Date Contract Duration Contract ID One-Time Costs Contract Costs
4 |Emotion Electronics  |A100 6/1/2019 12 Month Term A100 S 2,100.00 $ 12,500.00
5 |Emotion Electronics  |A101 6/1/2020 12 Month Term [EMPTY] S - S -
6 |Emotion Electronics  |[EMPTY] 1/1/1900 [EMPTY] A110 S 1,400.00 S 12,500.00
7 |Smith Marketing 28501 6/1/2018 12 Month Term 28501 S 8,400.00 S 10,125.00
8 |Smith Marketing 34886 6/1/2019 12 Month Term 34886 S 1,850.00 $ 12,750.00
9 |Express Services 001684-0197 10/21/2019 24 Month Term 001684-0197 S - S 1,840.00
10  ACME Company AC1217 4/1/2018 12 Month Term AC1217 S 2,500.00 $ 5,000.00
11 |ACME Company AC1924 4/1/2019 12 Month Term AC1924 S - S 5,300.00
12 /ACME Company AC2101 4/1/2020 12 Month Term AC2101 S 500.00 $ 6,150.00
13 |Fred's Grocery [EMPTY] 1/1/1900 [EMPTY] [EMPTY] S - S -
14 |Fred's Grocery [EMPTY] 1/1/1900 [EMPTY] [EMPTY] S S -
Contract Details ® <
Notes:

¢ To delete a matrix join statement from an Accolade Excel report, click Data Reports in
the Accolade menu on the Excel ribbon and click the name of the report to open it for

editing. Click the Advanced Matrix Settings tab, and click 0 in the corresponding
definition row to delete it. Click Done to apply your changes and generate the report and
save your changes to the report.



Excel Report Templates Overview

Add MS Excel report teplates to the Charts & Reports page within Accolade and to a process model for
availability within a project. These reports are built and viewable in MS Excel, provide flexibility in
formatting, and can be created using the Accolade Office Extensions add-in application. The application
provides an interface to create a data report based on Accolade data. You can also create MS Excel
reports using a template and the Accolade query infrastructure, creating charts and tables based on
data pulled into the spreadsheet using queries.

Creating Excel Report Templates using Accolade Office Extensions

Create an online report within Accolade instead of in Excel using the Accolade
Office Extensions add-in to create a refreshable report without having to leave
Accolade and without having to install the Accolade Office Extensions add-in.

Anyone in your organization with All Reporting Rights can create an Excel report using the Accolade
Office Extensions add-in. Created reports via the add-in provides the following advantages:

¢ No SQL knowledge is required. You can select Accolade data directly from the report interface
without writing SQL queries.

¢ Reports can be refreshed when downloaded from Accolade to contain up-to-date information
and formatted for distribution or review, query-based tables cannot.

The information below assumes you are using the Accolade Office Extensions add-in to create reports
and assumes you are familiar with basic Excel functionality. For more information about manipulating
the data in a report, see the online Help available from within the add-in.

To create an MS Excel report:

1. Open Excel and navigate to the Accolade menu in the Excel ribbon.

This allows Excel to pull data from Accolade into the report and allows reports to be created or
refreshed to display current Accolade information.

If necessary, connect to the appropriate server by clicking Server and entering the
server URL.

2. Click Data Reports and do one of the following:
¢ To add a new report - Click Add New.

¢ To edit an existing report - Click the name of the report to open it for editing.

* To create a report based on an existing report - Click E to copy the report.

Use the arrow in the Report Name heading to sort reports in ascending or
descending order.

3. Select a subject from the drop-down list, such as Projects or Users, to display the column sets
available within that subject.



Double-click or drag and drop the column names from the left side of the dialog to any area in the
Columns tab to include the column in the report.

To search for a column, enter search criteria in the Find field after selecting the subject.

Use the and =] options to expand or collapse the subject data sets in order to select
specific column options.

To include an entire column set, drag and drop the column set to the Columns tab.

To change the column order of selected columns, drag and drop a column into a new location
within the list.

To remove a column, click O in the corresponding row.

(Optional) Refine the content of the report as necessary.

Rename columns - Click in one or more selected columns and enter a new column name
that is more appropriate for the report you are creating.

Set column sorting - Click - next to one or more selected columns to indicate whether the
column is sorted in ascending or descending order. If you select more than one column to
sort by, indicate the order in which the columns sort; 1 being the primary sort, 2 the
secondary sort, and so on.

Determine column properties - For number and date columns, click Z or ﬁ in the
Properties area to group data together by aggregation or select date formats. Select the
aggregate method or date format and click away to apply the changes. All selected
aggregate methods are added to the report columns list with the aggregate method
appended to the column name.

For example, to summarize the total costs for all projects within a brand, select Sum as the
aggregate value in a column that represents the total costs for a project.

Add Count Column - If you select to summarize values within the report, click +] Add
Count Column to add a column that shows how many rows of source data are combined in
the summary row.

You can order and rename the added column as you can other columns; however,
you can add only one Count column to the report.

Add Calculated Column - Click L+ Add Calculated Column to add a column to the report
that displays a calculation based on other column data.

(Optional) On the Filters tab, double-click or drag and drop the column name from the left side of
the dialog to any area in the Filters tab to use it as filter criteria that data must match to be
included in the report.

(Optional) On the Report Details tab, add the following information:

Field Description

Report Name Enter a name which identifies the report.




Field

Description

Report Location

Select one of the following options for the location to place the

report:

» Existing worksheet - Select this check box to add the report
to an existing worksheet that does not already contain a
report, and select the appropriate existing worksheet name
from the drop-down list.

« New worksheet - Select this check box to create and add the
report to a new worksheet, and enter the name for the new
worksheet.

Override Project

Select this check box to include the entire report set from within

Filtering a project. The report will not filter to project-specific data when
viewed from within a project, and will display all projects in a
portfolio regardless of security.

Transpose Select this check box to transpose the column and row data

when the report is rendered.

8. Onthe Advanced Matrix Settings tab, if more than one matrix was selected in the report

columns, click + Add to add the matrix join definitions.

9. Click Done to apply your changes and generate the report.

10. Save the report to an accessible location.

11. Add the report to the Template Library using the Report type for access within Accolade.

Creating Excel Report Templates Using Queries

Note: Although the Report - Excel <version>.xltx base template is still available, Sopheon
recommends creating online reports available from Workspace > My Workspace >
Charts & Reports, or using the Accolade Office Extensions add-in.

If you are comfortable writing SQL queries, or if you need to create a report that requires an advanced

database query, add a workbook to an Excel file that is populated with data from queries created within
Accolade. To use queries within an Excel report, use the Report - Excel <version>.xltx base template

available on the Base Templates Reference Page. This file is set with the workbooks and structure
required for creating Excel reports that contain queries.

You can create a file based on Report - Excel <version>.xltx and save it to the Template Library to
use as a base template for similar reports. However, in doing so:

¢ Do not delete, insert, or rearrange the data columns on the data worksheets. The column
structure on these worksheets must match that of their queries. Rewrite queries to match the

data worksheets.

« Do not add Excel pivot tables or other sets of data to the data worksheets.
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* Do not add formulas to the columns of the data tables on the data worksheets. You can add

formulas to the columns to the right of the rightmost query-populated column. The import
automatically propagates the formulas across the imported data.

¢ Include only numbers, letters, underscores, and periods in the heading of a formula column.

Other characters cause an "Invalid Name" error when the workbook is opened in Accolade.

The information below describes how to add queries to an Excel file. For information about the Accolade
query infrastructure, see the Queries Overview topic in the online Help.

Note: The queries that are available for selection are based on your access group
permissions as defined in your user profile. Only queries that the user has "Can Edit"
access for will be available for selection. Additionally, access group settings for the
query must match the user permissions of other Process Designers in order to display
for them.

To create an MS Excel report using a query:

Note: The following procedure assumes that you have created the appropriate queries for
the report and that you are familiar with basic Excel functionality.

. Add an Excel report to Accolade.

Select the queries to use in the report and select either the Report - Excel <version>.xltx file or
a template based on it as the template file.

Click Preview to populate Accolade data into the file and save the preview file to your computer.

Save the file using a name that identifies the nature and purpose of the report. This is the file that
becomes the template that is added back to the Template Library.

Check the first data worksheet to confirm that the data is what you want and to identify the cell
range it occupies.

For the workbook to refresh correctly, the worksheet must contain at least two rows of data. If the
query only retrieved one row, add a second row of data manually on the data worksheet and
identify both rows in data ranges.

(Optional) To manipulate the data with formulas, add the formulas to the right or left of the table.

Continue to format the workbook by inspecting the next data worksheet, adding a new
worksheet, and creating a report. You can create one or more reports for each data worksheet in
the workbook.

Hide the data worksheets and any other worksheets that users of the report should not modify.

Save the completed Excel workbook to your computer and add the template to the Template
Library.

From the System menu, select Content Sources > Charts & Reports Manager, and click the
name of the report you created in step 1.

In the Template field, select the MS Excel file you added to the Template Library in step 8.
Click Update to save the changes to the report.
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Notes:

¢ When a query refreshes the data set, it can retrieve more, or fewer rows, but it cannot
retrieve a different number of columns from the database.

Creating MS Excel Reports in Project Currencies

By default, currency values included in MS Excel reports are shown in the corporate currency. However,
some projects may track their values in a local currency that is different than the corporate currency. To
convert values into the project currency, use the Currency Report Template <version>.xltm base
template available on the Base Templates Reference Page, or in the Template Library, as a starting
point to build the report.

Note: The information in this topic details how to create MS Excel reports if your currencies
are defined using the general currency conversions and Corporate Currency system
parameter method. If you use the recommended date-specific currency conversions
method, you can create a report in a project currency using calculations based on the
metrics defined to capture the project's currently selected currency. Before creating a
report that uses a project's currency, define the currency conversions.

To add a currency conversion to a project report template, add a conversion table to a worksheet within
the file and set cross references from the report cells to the conversions. You can also select the format
in which currencies display.

Note: An Administrator or Process Designer must also have All Rights to Reporting for
access to create the Accolade Office Extensions report using the currency
conversions reference table.

To create an MS Excel report in a project’s currency:
Note: The procedure below assumes that you have Accolade Office Extensions installed.
1. Save the Currency Report Template <version>.xltm file to your computer and open the file in
Excel.
2. Within Accolade Office Extensions, click Data Reports and click Add New to add a report.

3. Select the Reference Tables subject.

4. Select Currency Conversions from the Available Reference Tables list, and select to include
the Currency Code and Conversion Factor columns in the table.

These two columns enable you to select the correct conversion factor to convert the corporate
currency values in the database into the project currency values you want to display in the report.
You can select additional columns that may be helpful in identifying the currencies available.

5. Continue through the dialog options, select the worksheet and provide a table name that
identifies the table as the currency conversion table, and click Finish to add the table.
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9.
10.

Conversion tables are typically included on a separate worksheet so you can hide
the worksheet before adding the report template to the Template Library.

Create the rest of the report, including the currency metrics to convert.

In the cell where you want to convert a currency value, enter the following formula:
=ConvertToCurrency(cell, "code")
where

e cell isthe reference to cell containing the value to convert

¢ code is the three-digit currency code of the currency to convert to. The code must be
contained in quotes.

For example, =ConvertToCurrency (A2, "JPY") to convert the currency from the corporate
currency to Japanese Yen.

To format the value, see the procedure below.
Copy the formula down the right side of the table to every row containing values to be converted
to the project currency and hide the column that contains the values to be converted.

Adding the formulas to the column to the right of the column containing the corporate currency
values leaves the column of converted values in the original position of the now hidden column

Save the file with a name that clearly identifies the nature and purpose of the report.

Add the file to the Template Library.

To format a currency value in an MS Excel report:

1.
2.

Open areport that contains a currency conversion table (as created in the procedure above).

Open the Accolade menu in the MS Excel ribbon, select the conversion table you created in the
procedure above and click Modify.

3. Select toinclude Format 1 and Format 2 and click Finish.

4. Inthe cells that contain the =ConvertToCurrency (cell, "code") formula (see step 6
above), add the format column heading parameter.
=ConvertToCurrency(cell, "code", "format column heading")
This parameter is either Format1 or Format2 in the Currency Conversion table you modified in
step 3 that contains the numeric format to display.
iy
EXAMPLE
e Example
D4 T B A =ConvertToCurrency(B4, "JPY", "Format 1")
A | B | c [ o ] E |
| 1 My Currency Report
2
I Project Name DBE Cost [USD] DBE Revenue [USD] Cost [JPY] Revenue [IPY]
| 4 |My Example 1500 4500| ¥6000_| ¥18000

£

Note the formula displayed in the formula field.

5. Save thefile and add it to the Template Library.
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Adding Excel Report Templates to Accolade

For an Excel report to be viewable in the Charts & Reports page or in projects within Accolade, an
Administrator or Process Designer must add the report to Accolade.

To add an Excel report to Accolade:

Note: You must have a report template with the type Spreadsheet Report saved in the
Template Library prior to adding an Excel report using the instructions below.

1. From the System menu, select Content Sources > Charts & Reports Manager.

To narrow the list, search by the report name or category.

2. Do one of the following:

¢ To add a new report - Click Add New and select MS Excel Report from the drop-down list.

¢ To edit an existing report - Click the name of the report to open it for editing.

3. Complete the following information to identify and describe the report:

Required fields display with red text and an asterisk * if the field is empty.

Field

Description

Name

Enter a name, up to 64 characters long, which identifies the
report.

System Name

Enter a unique, shorter name that identifies the report in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among reports, and can contain
only letters (English alphabet), numbers, and the underscore.

Description

Enter a description of the purpose or nature of the report.

This description helps other users identify the report
throughout the system.

Category

Enter or select the group to which this report belongs.

Use categories to organize like reports together. For example,
if there is a large number of financial reports, a Project
Manager can use a category selection to locate only financial
reports.

e Leave this field blank to add to the Default category.

» Todefine a new category, select New Category and enter
the category name.

» Todelete a category, remove every item from the category.
Empty categories are deleted automatically.

Query

If the report is created using the Accolade query infrastructure,
select up to five queries to create tables in the report.




Field

Description

Each query copies its data to the indicated Excel worksheet.

Configuration Access
Groups

Select the access groups to which the report belongs.

Process Designers with matching permissions will be able to
edit and view the report. The access groups displayed are
based on the current user's access group permissions and the
access groups the report belongs to.

Process Model Usage

Click the Process Model Usage button to see a list of process
models that the MS Excel report is associated with.

The list includes all process models the report is included in, as
well as links to the process model's component tree pages you
have Edit access to.

Active In

Select where the report is available within Accolade.

¢ Charts & Reports - Displays the report on the Charts &
Reports page. Clicking this check box places the report in
the Shared Charts & Reports section of the Charts &
Reports page. If unchecked, the report will only be
available to the assigned owners in their My Charts &
Reports section.

¢ Projects - Displays the report within a project. Clicking this
check box will make the report available for association with
a process model.

If the report is not ready for viewing, clear all the check boxes.

Template

Select the file from the Template Library that serves as the
basis for the report.

Roles

Select the system user roles that have access to view the
report.

Users with one or more matching user roles and either Refresh
Workbook Data or All Reporting Rights will be able to view the
report on the Charts & Reports page, as well as select to
receive the report through an email if the report is available for
notifications.

4. Click Create to create a new report or Apply to save changes to an existing report.

Notes:

* Todelete an Excel report, display the report from the Charts & Reports page, click f. to
display the report settings, and click Delete at the bottom of the page. Only the report
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the report. Deleting a report does not delete the query or
the file in the Template Library on which the report is based. To remove a report from view
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but keep its definition for use later, clear the selections in the Active in field.

e Categories created for queries, HTML reports, or MS Excel reports are saved in common
and apply to all three. To remove a category from the list, ensure that no queries, HTML
reports, or MS Excel reports are assigned to the category.

Setting Custom Excel Report Template Properties

Using the Accolade Office Extensions add-in to create Excel reports, you can add and modify custom
properties based on your report and template needs. Use the custom Excel document properties
described below for Excel reports attached to a deliverable or activity or available from the Charts &
Reports page. Custom properties include how data is refreshed, server information, and where log files
are saved.

Note: Accolade does not refresh the data for non-document owners, regardless of the
settings in the file.

Refresh on Open

Microsoft templates contain a custom property, SGM_SYS_RefreshOnOpen, which determines how
the document's content is refreshed when it is opened in Accolade.

If the report is used as a template in a deliverable or activity, when a document owner downloads the
template from the Deliverable or Activity dialog within a project, the data is refreshed, regardless of the
SGM_SYS_RefreshOnOpen setting. For document versions, document owners are prompted to
refresh the data.

To set the refresh on open properties in an Excel report template:
1. Create the Excel report template and save it to Accolade.
2. Download the document and open it in Excel.
Downloading the document from Accolade saves Accolade-specific properties to the document.
3. Display the document's advanced properties.

How to display the advanced properties varies across applications and versions. Typically,
property options are located under the File menu. Refer to the Excel online Help for the specific
location in the version you are using.

4. Inthe Properties dialog box, click the Custom tab.

5. From the properties list, select SGM_SYS_RefreshOnOpen.

6. Inthe Value field, enter one of the following options:
« ALWAYS - Refreshes the template automatically on open from Charts & Reports.
« PROMPT - Displays a prompt to select whether to refresh the data.

7. Save the template and add it to the Template Library.



Refresh Fields on Worksheets

Add the custom SGM_RefreshFieldsOnWorksheet property to an Excel report template to specify
which worksheets are scanned for Accolade field codes. Specifying worksheets using this parameter
can improve the performance of large reports.

To set which worksheets to scan for field code refresh:

1.
2.
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Create the Excel report template and save it to Accolade.

Download the document and open it in Excel.

Downloading the document from Accolade saves Accolade-specific properties to the document.
Display the document's advanced properties.

How to display the advanced properties varies across applications and versions. Typically,
property options are located under the File menu. Refer to the Excel online Help for the specific
location in the version you are using.

In the Properties dialog box, click the Custom tab.
In the Name field, enter the case sensitive name SGM_RefreshFieldsOnWorksheet.
From the Type list, select Text.

In the Value field, enter the names of the worksheets that contain Accolade field codes,
separating the names with a backslash (\).

Click Add.
Save the template and add it to the Template Library.

Enable Output Log Files

Add the custom SGM_LOG_DIRECTORY property to an Excel report template to create an output file
that collects log files from the Accolade Office Extensions add-in. Use the generated logs file when
troubleshooting server call issues.

1.
2.
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Create the Excel report template and save it to Accolade.

Download the document and open it in Excel.

Downloading the document from Accolade saves Accolade-specific properties to the document.
Display the document's advanced properties.

In the Properties dialog box, click the Custom tab.

In the Name field, enter the case sensitive name SGM_LOG_DIRECTORY.

From the Type list, select Text.

In the Value field, enter a file folder path where the logs will collect.

Click Add.

Save the template and add it to the Template Library. Save the workbook with the added custom
property to enable the add-in to collect logs to the specified directly.

To disable the add-in from collecting logs, remove the custom property and save the workbook.



Creating Macros for Microsoft Document Events

Several events exist for Microsoft documents when users have installed Accolade Office Extensions.
Administrators and Process Designers can write macros that these events call to add additional
functionality to respond to the events.

Using these macros requires that you create a module named SGMEvents in the document.

« SGMRefreshStarted - Called after the Refresh Data From Server command has been clicked.
Public Sub SGMRefreshStarted ()

« SGMRefreshComplete - Called after all tables and charts have been refreshed.
Public Sub SGMRefreshComplete()

« SGMTableRefreshStarted - Called after user clicks Save after modifying a table.
Public Sub SGMTableRefreshStarted (Optional sTableRangeName as string)

« SGMTableRefreshComplete - Called after a single table is refreshed. And called again after all
tables are refreshed.

Public Sub SGMTableRefreshComplete (Optional sTableRangeName As String)

Exercises - Creating Online Reports
Try out what you have learned!

¢ Open MS Excel and use Accolade Office Extensions to create a
report that includes all open projects that started after a date of your
choosing. Use the Projects subject to select the columns to include,
including a filter on Project Start Date.

» Set the report to sort with the newest projects created first.

e Save the file and add it to the Template Library in Accolade.

Creating HTML Reports

An HTML report uses a single SQL query to gather data and can be accessible from the Charts &
Reports page or from within a project. Users who have the role assignment selected in the report can
also select to receive the report in the body of an email.

Use the Report Privacy Warning Text system parameter to add a notification
within the report to indicate the content is private or confidential, and should not be
forwarded to others.

Consider the following when designing HTML reports:

¢ An HTML report displayed on the Charts & Reports page may display information about
multiple projects. That same report displayed within a project contains only the data for that
project. Data that is not project-related is displayed the same in both locations.



e HTML reports can range in size. Ensure your company's email server accommodates the file
size and volume required to send required reports to all the selected users

* HTML reports display in a set, non-editable format. To create a report using formatting, create an
MS Excel report and format it as necessary.

Prior to creating an HTML report, create and save the SQL Query on which the HTML report is based.

Note: The queries that are available for selection are based on your access group
permissions as defined in your user profile. Only queries that the user has "Can Edit"
access for will be available for selection. Additionally, access group settings for the
query must match the user permissions of other Process Designers in order to display
for them.

To create an HTML report:
1. From the System menu, select Content Sources > Charts & Reports Manager.
To narrow the list, search by the report name or category.
2. Do one of the following:

¢ To add a new report - Click Add New and select HTML Report from the drop-down list.

* To edit an existing report - Click the name of the report to edit and click i’. to edit the report
details.

3. Complete the following information to identify and define the data included in the report:

Required fields display with red text and an asterisk * if the field is empty.

Field Description
Name Enter a name, up to 64 characters long, which identifies the report.
System Name Enter a unique, shorter name that identifies the report in queries,

reporting views, field codes, and other places in Accolade.

The name must be unique among reports, and can contain only
letters (English alphabet), numbers, and the underscore.

Description Enter a description of the purpose or nature of the report.
This description helps other users identify the report throughout
the system.

Category Enter or select the group to which this report belongs.

Use categories to organize like reports together. For example, if
there are a large number of reports that the IT department uses to
track user logins, use a category to group those reports together.

¢ Leave this field blank to add to the Default category.

¢ To define a new category, select New Category and enter the
category name.

¢ To delete a category, remove every item from the category.
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Field

Description

Empty categories are deleted automatically.

Query

Select a saved query.

The report displays data gathered from the database for the
defined query.

When defining the query for the report, using
LinkableName instead of the ProjectName column
makes the project's name a hyperlink to the project from
the generated email.

Notification

Select the Notifications option from the following:

¢ Hide - The report is not available for selection on the My
Profile page.

¢ Show - Displays the report as an option to schedule, share, or
receive immediately on the My Profile page for users with the
roles selected in the Roles field.

¢ Required - Makes the report required and lists it on the My
Profile page for users with the roles selected in the Roles field.
Select the days of the week that the report is sent to the
selected users. Users can modify the day selections or choose
to not receive required reports on their My Profile page.

Configuration
Access Groups

Select the access groups to which the report belongs.

Process Designers with matching permissions will be able to edit
and view the report. The access groups displayed are based on
the current user's access group permissions and the access
groups the report belongs to.

Process Model
Usage

Click the Process Model Usage button to see a list of process
models that the HTML report is associated with.

The list includes all process models the report is included in, as
well as links to the process model's component tree pages you
have Edit access to.

Active In

Select where the report is available within Accolade.

¢ Charts & Reports - Displays the report on the Charts &
Reports page. Clicking this check box will place the report in
the Shared Charts & Reports section of the Charts &
Reports page. If unchecked, the report will only be available to
the assigned owners in their My Charts & Reports section.

¢ Projects - Displays the report within a project. For a report to
be available for association with a process model, it must be
active in projects.

If the report is not ready for viewing, clear all the check boxes.
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Field Description

Transpose Select the check box to display reports that contain only one
project as a vertical column rather than a row.

If you select to transpose a report that contains reports for multiple
projects, the transposed result displays data for only the first
project in the report.

Roles Select the system user roles that have access to view the report.

Users with one or more matching user roles and either Refresh
Workbook Data or All Reporting Rights will be able to view the
report on the Charts & Reports page, as well as select to receive
the report through an email if the report is available for
notifications.

4. Click a in the Report Details to ensure the report pulls the correct data and is working as you

intended. Click i”. to return to the Report Details after previewing the report.

5. Click Create to create the new report or Apply to save changes to an existing report.

Notes:

¢ Todisplay an HTML report within a project, the report must added at the process model
level, either by adding it to the Reports List pod, or by adding it to a pod within a layout that
is assigned to the process model.

* Todelete an HTML report, display the report from the Charts & Reports page, click ﬁ’.
to display the report settings, and click Delete at the bottom of the page. Only the report
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the report. Deleting a report does not delete the query on
which the report is based. To remove a report from view but keep its definition for use
later, clear the selections in the Active in field.

e Categories created for queries, HTML reports, or MS Excel reports are saved in common
and apply to all three. To remove a category from the list, ensure that no queries, HTML
reports, or MS Excel reports are assigned to the category.
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Viewing Charts and Reports in Accolade

Reporting in Accolade provides a means to summarize and analyze project and other data within your
database in a format and manner that is most applicable to your organization and data needs.

Charts and reports displayed at a system-level allow users to analyze and compare projects across a
portfolio, while charts and reports displayed at a project-level allow users to summarize a single
project's status and relevant information.

L.1_I_
A PLE Example

For example, consider a report or chart that contains various project details for every project in the
system. When displayed at a global level, either on the Charts & Reports page or in a page layout
displayed as a global link, it displays the details for all included projects. When displayed at a project

level, in a project page layout, it only displays the given project details.

Viewing System-Level Charts or Reports

The Charts & Reports page provides a single location for accessing and viewing online reports and
charts within Accolade. Users must have Refresh Workbook Data or All Reporting Rights to view an
online report or chart.

The Charts & Reports page is organized into two sections to help users quickly navigate to their
information:

¢ My Charts & Reports: Items that appear here are considered private. You must be assigned as
an owner of the chart or report, and it is not marked on the configuration side as Available.

Note: An assigned owner with All Reporting Rights can view, update, delete, or add
additional owners to the chart or report. An assigned owner who has Refresh
Workbook Data rights will only be able to view the chart or report.

+ Shared Charts & Reports: Items that appear here are considered public. They are available for
users to view if the chart or report is marked on the configuration side as Available. If the item is
restricted to specific roles, users must also have a matching system user role assigned.

Important! The reports that display for selection are based on your access group
permissions as defined in your user profile.

Note: Charts and reports that are included in a page layout can also be viewed within a
global link, if they are included in your company's configuration.

To view an available chart or report:

1. From the System menu, select Content Sources > Charts & Reports Manager.



Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the System menu and selecting Content Sources > Charts & Reports
Manager.

2. Click the name of the chart or report you want to view.

To narrow the list, search by name or category.

3. (Optional, as available and applies to reports only) Click Eﬁ in the upper right corner to download
the current version of the report.

Viewing Project-Level Charts or Reports

In addition to viewing system-wide information in the charts and reports available on the Charts &
Reports page, Administrators and Process Designers can associate charts and reports with a process
model to display data within a project. When viewed through a project, only data that pertains to that
project displays in the chart or report, unless Override project filtering is set in the report
configuration.

Charts and reports can be displayed in a project by two different methods:

¢ Displayed on the project using a Report List pod on a layout - MS Excel or HTML reports are
configured in the pod's advanced settings. Users with appropriate rights can click on a report
name to open it for viewing or downloading, depending on the report's configuration.

Click E on the Report List pod on the layout to print the list of charts and reports
that display.

¢ Added to a project page layout - HTML reports, online reports, and charts created from online
report data can be added to a page layout that is associated with the process model, and can be
accessed by opening the related custom page in the project's page list. This method of displaying
areport allows users to view multiple data sources at one time, and to apply runtime filters in
order to filter the project information displayed in the charts and/or reports.

Applying Runtime Filters to Charts or Reports

Users can apply runtime filters to charts or reports that are displayed within a page layout that is used as
a project page or as a global link. Filters can be used to further modify the data displayed without
making adjustments to the original data source, allowing users flexibility to display the information that is
relevant to their role.

Runtime filters can be selected and applied either to a single report or chart, or to all charts and reports
that are displayed in the layout.

In order to apply runtime filters, the selected reports must be set up with filters that
have runtime filtering enabled, and the selected charts must be created from an
online report with filters that have runtime filtering enabled.



To apply filtering to an individual chart or report on a layout:

1.

Display the layout that contains the chart or report to be filtered.

Each chart or report lists the runtime filters that are currently applied.

Click Y in the upper right corner of the chart or report to open the Report Filters dialog box.

The filter categories applied to the selection will appear in the list. If the selection does not have
runtime filters configured, the message "No filters have been defined" will display in the dialog.

For each filter row, enter the value to apply as filter criteria.

Important! A value must be defined for all filters in the dialog box. If you do not wish to apply
a particular filter, you will need to set its value to something that will not cause data to be
filtered out.

Click Apply to apply the filters and refresh the data displayed.

(Optional, as available and applies to reports only) Click E} in the upper right corner to download
the current version of a report.

To apply filtering to all charts and reports on a layout:

Note: Enable layout filters must be selected on the layout configuration in order to use this
process to apply runtime filters to all charts or reports in a layout.

Display the layout that contains the charts or reports to be filtered.

Page Filters appears in the upper left corner, along with a list of the filters that are currently
applied to all charts and reports on the layout. In addition, each chart or report lists any unique
runtime filters that are currently applied.

Click Y to open the Page Filters dialog box.

In order to be available to apply to the layout, filter categories must be included in the
configuration for all charts and reports on the layout.

If the selection does not have runtime filters configured, the message "No filters have been
defined" will display in the dialog.

For each filter row, enter the value to apply as filter criteria.

Important! A value must be defined for all filters in the dialog box. If you do not wish to apply
a particular filter, you will need to set its value to something that will not cause data to be
filtered out.

Click Apply to apply the filters and refresh the data displayed.

(Optional, as available and applies to reports only) Click m in the upper right corner to download
the current version of a report.



Using Accolade Tools to Interact With Online Reports

Access the enhanced search, filter, and sort capabilities in Accolade’s Charts and Reports section.
These enhancements allow users to search, filter, sort, and hide/show columns in reports in a more
efficient way and organize pertinent information quickly.

Note: Refreshing the page will reset any filters or sorting.
To column filter all charts and reports in Accolade

¢ Access the new icon that is located in the column header that will allow users to select filtering
options, using checkboxes, to apply to their report search.

¢ Utilize the newest search functionality that allows users to find filtering options to apply.
¢ Use the new icon located at the top right of the report to remove any filters applied to the report.
To search all charts and reports in Accolade
¢ Select the Search Bar at the top-right corner of the report to keyword search within the report.
Note: The keyword search is not case sensitive.
¢ Click the Xicon in the Search Bar to clear the keyword search data.
To show/hide columns in Accolade

¢ Select the icon displayed in the top-right corner of the report to show or hide columns within that
report.

¢ Uncheck the box next to the column name and click the Apply button to hide the column.
To effectively control columns widths in Accolade

¢ Hover over the header bar in the report to see the lines separating each column. Users can now
click and drag to expand or minimize that specific column.

¢ Double click the line separating each column to set the column back to the original size (Auto-
Sizing).

« Display full text contents of the cell by clicking onto that specific cell when the text is truncated
due to the smaller size of the column.

To interactively sort all charts and reports in Accolade
¢ Click on any column header in the report to sort the report based on the data within that column.

¢ Clicking once on a column will sort in ascending order, clicking twice will sort in descending
order, and clicking a third time will revert to the default report sort order.

* Click on the Save Preferences icon @ in the top-right of the report to save your column widths
and hidden columns.



Notes:

Accolade data is automatically refreshed with current values each time you open a chart
or report.

To clear the current values set for a runtime filter, click Y to open the Report Filters

dialog and click D in the corresponding filter row. This sets the filter back to the default
settings as defined at the chart level.

Filter icon will not appear if there are no filters available for users to apply.

From the Charts & Reports page, you can send an HTML report via email directly to

yourself or to others. Click the name to display the report, and click “« in the upper right
corner. In the dialog, select the users you want to send the report to and click Done.
Accolade sends a copy of the report to you and the selected users with the same data that
displays to you. If there is sensitive data in the report, take caution in sending it to others.

If you have Accolade Office Extensions installed on your computer, you can save an MS
Excel report to your computer and then refresh its Accolade data without starting
Accolade.

To explore "what if" scenarios, save an MS Excel report to your computer, unhide the data
worksheets if necessary, modify the data, and then observe the effect of the changes on
the charts and reports in that workbook. Scenarios can also be created using a report's
filter options.
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